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About this manual

Overview

This product supplement contains all information required for the
deployment of the Slot-PLC 517S/DPM in your PC. The here described
Slot-PLC is a SPEED7 CPU 517S/DPM with integrated Profibus-DP
master. The CPU is included in the PC as Ethernet interface and can be
accessed via the IP address.

Chapter 1: Basics

This Basics contain hints for the usage and information about the project
engineering of a System 500S SPEED7 from VIPA.
Basic information about the structure of IP addresses can be found further.

Chapter 2: Hardware description

In this chapter the hardware components of the CPU 517S/DPM are more
described here.

The chapter closes with the technical data.

Chapter 3: Deployment CPU 517S/DPM

Main topic of this chapter is the deployment of the CPU 517S/DPM from
VIPA. Here information necessary for installation, start-up and project
engineering can be found.

Chapter 4: Deployment CPU with Profibus

Content of this chapter is the deployment of the CPU 517S/DPM with
Profibus. After a short overview the project engineering and parameteri-
zation of a CPU 575S/DPM with integrated Profibus part from VIPA is
shown.

Further you get information about usage as DP master and DP slave of the
Profibus part.

The chapter is ended with notes to commissioning and start-up.

Chapter 5: Deployment PtP Communication

In this chapter the deployment of the RS485 slot for serial PtP
communication is described.

Here you'll find all information about the protocols and project engineering
of the interface, which are necessary for the serial communication using
the RS485 interface.

Chapter 6: Deployment PLC-Tool

This chapter contains the description of the control software PLC-Tool from
VIPA. PLC-Tool is a component of the OPC-Server package and is
installed together with the OPC server at the standard installation.

The OPC-Server package may be found at the enclosed CD SW-
ToolDemo.

HB145E - CPU - RE_517-2AJ02 - Rev. 10/23 1
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Chapter 6: WinPLC7

In this chapter the programming and simulation software WinPLC7 from
VIPA is presented. WinPLC7 is suited for every with Siemens STEP®7
programmable PLC.

Besides the system presentation and installation here the basics for using
the software is explained with a sample project.

More information concerning the usage of WinPLC7 may be found in the
online help respectively in the online documentation of WinPLC7.

HB145E - CPU - RE_517-2AJ02 - Rev. 10/23
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About this manual

Objective and
contents

Target audience

Structure of the
manual

Guide to the
document

Availability

Icons
Headings

This manual describes the System 500S SPEED7 517S/DPM from VIPA.
It contains a description of the construction, project implementation and

usage.

This manual is part of the documentation package with order number

HB145E_CPU and relevant for:

Product Order number as of state:
CPU-HW |CPU-FW |DPM-FW
CPU 517S/DPM VIPA 517-2AJ02 01 V351 V326

The manual is targeted at users who have a background in automation

technology.

The manual consists of chapters. Every chapter provides a self-contained

description of a specific topic.

The following guides are available in the manual:
» an overall table of contents at the beginning of the manual
» an overview of the topics for every chapter

* an index at the end of the manual.

The manual is available in:
» printed form, on paper

* in electronic form as PDF-file (Adobe Acrobat Reader)

Important passages in the text are highlighted by following icons and

headings:

Danger!
Immediate or likely danger.
Personal injury is possible.

Attention!

Damages to property is likely if these warnings are not heeded.

Note!

Supplementary information and useful tips.

HB145E - CPU - RE_517-2AJ02 - Rev. 10/23
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Safety information

Applications The SPEED7 CPU is constructed and produced for:

conforming with .
specifications .

communication and process control
general control and automation applications
industrial applications

operation within the environmental conditions specified in the technical
data

installation into a cubicle

Danger!
This device is not certified for applications in

in explosive environments (EX-zone)

Documentation The manual must be available to all personnel in the

project design department
installation department
commissioning

operation

The following conditions must be met before using or commissioning
the components described in this manual:

Modification to the process control system should only be carried out
when the system has been disconnected from power!

Installation and modifications only by properly trained personnel

The national rules and regulations of the respective country must be
satisfied (installation, safety, EMC ...)

Disposal National rules and regulations apply to the disposal of the unit!

HB145E - CPU - RE_517-2AJ02 - Rev. 10/23
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Chapter 1

Overview

Content

Basics

This Basics contain hints for the usage and information about the project
engineering of a System 500S SPEED7 from VIPA.

Basic information about the structure of IP addresses can be found further.

Topic Page
Chapter 1 BaSICS oottt 1-1
Safety Information for USers...........oooviiiiiiiiicc e, 1-2
Principles of Net-ID, Subnet-ID, Host-ID ............ccccvvvcieeiiiii, 1-3
Operating structure of @ CPU ..o 1-6
CPU APPHCAtIONS ....uueiiiiiiiiiii s 1-7
Operands of the CPU ........coooi i 1-7
CPU BA7SIDPM ... essssnsnnnnnnnnes 1-9
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Safety Information for Users

Handling of
electrostatic
sensitive modules

Shipping of
electrostatic
sensitive modules

Measurements and
alterations on
electrostatic
sensitive modules

VIPA modules make use of highly integrated components in MOS-
Technology. These components are extremely sensitive to over-voltages
that can occur during electrostatic discharges.

The following symbol is attached to modules that can be destroyed by
electrostatic discharges.

The Symbol is located on the module, the module rack or on packing
material and it indicates the presence of electrostatic sensitive equipment.
It is possible that electrostatic sensitive equipment is destroyed by energies
and voltages that are far less than the human threshold of perception.
These voltages can occur where persons do not discharge themselves
before handling electrostatic sensitive modules and they can damage
components thereby, causing the module to become inoperable or
unusable.

Modules that have been damaged by electrostatic discharges can fail after
a temperature change, mechanical shock or changes in the electrical load.

Only the consequent implementation of protection devices and meticulous
attention to the applicable rules and regulations for handling the respective
equipment can prevent failures of electrostatic sensitive modules.

Modules must be shipped in the original packing material.

When you are conducting measurements on electrostatic sensitive
modules you should take the following precautions:

» Floating instruments must be discharged before use.
* Instruments must be grounded.

Modifying electrostatic sensitive modules you should only use soldering
irons with grounded tips.

Attention!

Personnel and instruments should be grounded when working on
electrostatic sensitive modules.

1-2
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Chapter 1 Basics

Principles of Net-ID, Subnet-ID, Host-ID

Why Principles? The CPU 51xS PC plug-in card consists of a CPU and an Ethernet portion
that communicate via a TCP-based point-to-point connection. To enable
this, CPU and Ethernet portion each have an alterable IP address that may

only differ in the Host-ID.

PC

CPU 51xS

CPU

IP-Adr: Net-ID.Host-1D
Subnet cPy

Siemens SIMATIC

4 Manager

! Ethernet communication

Ethernet
[ IP-Adr: Net-ID.Host-ID,

Subnet

Windows driver

I L I

PCI slot

PCl communication

If you want to install several CPU 51xS in one PC, every CPU 51xS plug-in

card needs an own Net-ID.

The following text describes the approach for the assignment of IP

addresses together with Net-ID and Host-ID.

HB145E - CPU - RE_517-2AJ02 - Rev. 10/23
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Net-ID
Host-ID

Subnet-Mask

Every IP address is a combination of a Net-ID and a Host-ID.

The Network-ID identifies a network res. a network controller that
administrates the network.

The Host-ID marks the network connections of a participant (host) to this
network.

The Host-ID can be further divided into a Subnet-ID and a new Host-ID by
using an bit for bit AND assignment with the Subnet-Mask.

The area of the original Host-ID that is overwritten by 1 of the Subnet-Mask
becomes the Subnet-ID, the rest is the new Host-ID.

Subnet-Mask binary all "1" ‘ binary all "0"
IPv4 address Net-1D Host-ID
Subnet-Mask and |Pv4 address | Net-ID Subnet-ID ‘ new Host-1D

A TCP-based communication via point-to-point, hub or switch connection is
only possible between stations with identical Network-ID and Subnet-ID!
Different area must be connected with a router.

The Subnet-Mask allows you to sort the resources after your needs. This
means e.g. that every department gets an own subnet and thus does not
interfere another department.

Note!

When using the CPU 51xS in your PC, the Net-ID of the CPU 51xS must
not be assigned to another device. Otherwise you have to reassign the
addresses.

1-4
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Address classes  For IPv4 addresses there are five address formats (class A to class E) that
are all of a length of 4byte = 32bit.

Class A |0 |Network-ID Host-ID (24 bit)
(1+7 bit)
Class B [10 |Network-ID (2+14 bit) | Host-ID (16 bit)
Class C [110 |Network-ID (3+21 bit) | Host-ID (8 bit)

Class D [1110 |Multicast group

ClassE [11110 |Reserved

The classes A, B and C are used for individual addresses, class D for
multicast addresses and class E is reserved for special purposes.

The address formats of the classes A, B, C are only differing in the length
of Network-ID and Host-ID.

Private IP To build up private IP-Networks within the internet, RFC1597/1918
networks reserves the following address areas:
Network | Start IP End IP Standard Subnet Mask
class
A 10.0.0.0 10.255.255.255 255.0.0.0
B 172.16.0.0 [172.31.255.255 255.255.0.0
C 192.168.0.0 |192.168.255.255 |255.255.255.0

(The Host-ID is underlined.)

These addresses can be used as net-ID by several organizations without
causing conflicts, for these IP addresses are neither assigned in the
internet nor are routed in the internet.

Reserved Some Host-IDs are reserved for special purposes.
Host-Ids

Host-ID =0 Identifier of this network, reserved!

Host-ID = maximum (binary complete 1) Broadcast address of this network

Note!
Never choose an IP address with Host-ID=0 or Host-ID=maximum!

(e.g. for class B with Subnet Mask = 255.255.0.0, the "172.16.0.0" is
reserved and the "172.16.255.255" is occupied as local broadcast address
for this network.)
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Operating structure of a CPU

General

Cyclic processing

Timer processing

Alarm controlled
processing

Priority based
processing

The CPU contains a standard processor with internal program memory. In
connection with the integrated SPEED7 Technology receive you efficient
equipment for process automation.

A CPU supports the following modes of operation:

» cyclic operation

» timer processing

» alarm controlled operation
» priority based processing

Cyclic processing represents the major part of all the processes that are
executed in the CPU. Identical sequences of operations are repeated in a
never-ending cycle.

Where a process requires control signals at constant intervals you can
initiate certain operations based upon a timer, e.g. not critical monitoring
functions at one-second intervals.

If a process signal requires a quick response you would allocate this signal
to an alarm controlled procedure. An alarm can activate a procedure in
your program.

The above processes are handled by the CPU in accordance with their
priority. Since a timer or an alarm event requires a quick reaction, the
CPU will interrupt the cyclic processing when these high-priority events
occur to react to the event. Cyclic processing will resume, once the
reaction has been processed. This means that cyclic processing has the
lowest priority.

1-6
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CPU Applications

Overview

System routine

User application

The program that is present in every CPU is divided as follows:
» System routine
» User application

The system routine organizes all those functions and procedures of the
CPU that are not related to a specific control application.

This consists of all the functions that are required for the processing of a
specific control application. The operating modules provide the interfaces
to the system routines.

Operands of the CPU

Overview

Process image
and periphery

The following series of operands is available for programming the CPU:
* Process image and periphery

* Bit memory

» Timers and counters

» Data blocks

The user application can quickly access the process image of the inputs
and outputs PAA/PAE. You may manipulate the following types of data:

 individual Bits
* Bytes

« Words

* Double Words

You may also gain direct access to peripheral modules via the bus from
user application. The following types of data are available:

* Bytes
« Words
* Blocks

HB145E - CPU - RE_517-2AJ02 - Rev. 10/23 1-7
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Bit Memory The bit memory is an area of memory that is accessible by means of
certain operations. Bit memory is intended to store frequently used working
data.

You may access the following types of data:
* individual Bits

* Bytes

* Words

* Double words

Timers and In your program you may load cells of the timer with a value between 10ms

counters and 9990s. As soon as the user application executes a start-operation, the
value of this timer is decremented by the interval that you have specified
until it reaches zero.

You may load counter cells with an initial value (max. 999) and increment
or decrement these when required.

Data Blocks A data block contains constants or variables in the form of bytes, words or
double words. You may always access the current data block by means of
operands.

You may access the following types of data:
* individual Bits

* Bytes

* Words

* Double words

1-8 HB145E - CPU - RE_517-2AJ02 - Rev. 10/23
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CPU 517S/DPM

Overview

Memory
management

Integrated
Ethernet-PG/OP-
channel

Integrated
Profibus DP
master

MPI interface

The CPU 517S/DPM is a fully adequate PLC-CPU in form of a PCl-slot
card for PC-based applications. The operating systems Windows® 98, ME,
NT4, 2000 and XP are supported.

The range of performance is adequate to a SPEED7 CPU from the
System 300S from VIPA. The programming takes place via standard
programming tools like e.g. WinPLC7 from VIPA or STEP"7 from Siemens.

For the link up to the process level there is as well a MPI as a Profibus DP
master interface.
Further on, the VIPA OPC-Server is included in the delivery.

After the hardware installation, the card is linked up to the PC as COM
interface. The CPU component of the CPU 517S slot card can only be
operated with an external or internal DC 24V power supply. The external
supply enables the operation of the card outside of a PC res. independent
from the PC operation. Please consider for operation that the slot card is
connected to ground via its metal cover.

The CPU has an integrated work memory. During program run the total
memory is divided into 50% for program code and 50% for data.

There is the possibility to extend the total memory to its maximum by
means of a MCC memory extension card.

The CPU has an Ethernet interface for PG/OP communication. Only in
installed condition you have access via the PG/OP channel to your CPU.
Here you may program, remote control or show the integrated web page.
There are maximum 4 channels.

The CPU has an integrated Profibus DP master. Via the DP master with a
data range of 1kByte for in- and output up to 124 DP slaves may be
addressed. The project engineering takes place in WinPLC7 from VIPA or
in the hardware configurator from Siemens. Please regard there may be a
delimitation of the maximum number of configurable DP slaves by the use
of the Siemens SIMATIC manager.

The Profibus part may also be used as "intelligent" DP slave. More may be
found at "Deployment CPU with Profibus".
During operation the data range of the DP master is monitored at an

adjustable address area of the CPU. The address area may be by
hardware configuration.

The Slot PLC includes a MPI interface. On delivery the default MPI address
is 2. This address my be changed at any time via your CPU project
engineering tool.

HB145E - CPU - RE_517-2AJ02 - Rev. 10/23 1-9
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Operating security

Environment
conditions

Compatibility

Power supply

Operating options
via PLC-Tool

» External power supply of the CPU (autarkic operation)
» ESD/Burst acc. IEC 61000-4-2/IEC 61000-4-4 (up to level 3)
» Shock resistance acc. IEC 60068-2-6 / IEC 60068-2-27 (1G/12G)

» Operating temperature: 0 ... +60°C

» Storage temperature: -25 ... +70°C

* Relative humidity: 5 ... 95% without condensation
* Fanless operation

The SPEED7 CPUs from VIPA are instruction compatible to the
programming language STEP®7 from Siemens and may be programmed
via WinPLC7 from VIPA or via the Siemens SIMATIC Manager.

Here the instruction set of the S7-400 from Siemens is used.

Note!

Please do always use the CPU 318-2DP (6ES7 318-2AJ00-0AB0/V3.0)
from Siemens of the hardware catalog to project a CPU 517S/DPM from
VIPA.

For the project engineering, a thorough knowledge of the Siemens
SIMATIC Manager and the hardware configurator from Siemens is
required!

The CPU component of the 517S slot card can only be operated with an
external or internal DC 24V power supply. Simultaneous infeed should
absolutely be avoided!

Please consider for operation that the slot card is connected to ground via
its metal cover.

When connecting please consider that the internal power supply hardware
conditionally does not have an EMV filter for protection against
disturbances.

For operating the CPU via the PC the program "PLC-Tool" is included in
the consignment. For monitoring and operating of the CPU, your PC shows
an user interface that is modeled on the schematic view on a CPU front.

Via the PLC-Tool you may request the LED state and monitor res. change
the operating mode of the CPU.
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Chapter 2

Overview

Content

Hardware description

In this chapter the hardware components of the CPU 517S/DPM are more
described here.

The chapter closes with the technical data.

Topic Page
Chapter 2 Hardware description.......cccoeeevvieeiiiiiii e 2-1
PrOPEIIES ... 2-2
SHUCIUrE....co e, 2-3
COMPONENTS ... 2-4
TechniCal Data .......ccooiiiiiii e 2-9
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Properties

CPU 517S/DPM

517-2AJ02

Integrated SPEED7 technology

« Instruction compatible to STEP®7 from Siemens

» Project engineering via the SIMATIC Manager from Siemens
* Integrated DC 24V power supply

* MPI with max. 32 PG/OP connections with up to 12Mbit/s

» Status-LEDs for operating state and diagnosis

» Battery buffer for RAM and clock

* Integrated Profibus DP master

» Integrated work memory 2Mbyte expandable to 8Mbyte
(50% program - 50% data)

» Storage media slot for project engineering and firmware update
e 2048Timer, 2048 Counter, 16384 Memory-Byte

Ordering data

Type

Order number

Description

517S/DPM

VIPA 517-2AJ02

2Mbyte work memory expandable up to 8Mbyte

(50% program - 50% data), external power supply,

MPI, MMC slot, real time clock,

Interface: Profibus DP master, 12Mbit/s, up to 124 slaves,
PCI-Ethernet interface for PG/OP communication, incl.
SW110A2LA OPC-Server (SW110A2LA please order separate).
Incl. Drivers and SW860R OPC-Server (on the ToolDemo-CD).

2-2
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Structure

CPU 517S/DPM
517-2AJ02

SPEEI

com
PLC 7001

.

EA: 0020D5770095 &

L

B .
..:__-_[ll_‘___qi_.l!l o

[11 Clamp for internal DC 24V power supply

[2] LEDs for commissioning

[3] Lithium accumulator/battery for clock and user memory
[4] Storage media slot (here MMC is plugged)

[5] PCI bus pins

[6] RUN/STOP LEDs

[7] Operating mode switch

[8] Profibus DP master jack

[9] Plug for external DC 24V power supply

[10] MPI jack

HB145E - CPU - RE_517-2AJ02 - Rev. 10/23 2-3



Chapter 2 Hardware description

Manual VIPA System 500S SPEED7

Components

LED bar

On the plug-in module you can see a LED bar for status monitoring of the

CPU and the Profibus DP master. Especially at the commissioning and the
external usage of the module, the state of your CPU and your Profibus-DP

master is shown.

tables:

Master operation

At deployment inside a PC, you may issue the state of the LEDs on your
PC via the delivered software PLC-Tool.

The usage and the according colors of the LEDs are to see in the following

RUN [ ERR | DE IF | Meaning
green| red |green| red
Master has no project, this means the DP
O O O O interface is not used.
Master is in "clear" state (safety state). The
¢ O {} O inputs of the slaves may be read. The outputs
are disabled.
® o s o Master is in "operate" state (CPU RUN), this
means data exchange between master and
slaves. The outputs may be accessed.
® | ®@ | It | O
At least 1 slave is missing.
[ [ [ O
O O O @® | Initialization error at faulty parameterization.
Waiting state for start command from CPU
O ® O ® (state at start-up).
Slave operation
RUN | ERR | DE IF | Meaning
green| red |green| red
O O O O | Slave has no project respectively.
%:} O O O |Slave is without master.
X | O | ¥t | O |Alternate flashing at configuration faults.
o O o O |Slave exchanges data between master.
on: @ offt O flashing: ¥t

2-4
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... continue Label | Color |Description
LEDs
Ethernet
COLL green | Collision:  on: total duplex operation active

off: half duplex operation active
blinking: Collision detected
SPEED green | Speed: on: 100Mbit

off: 10Mbit
LINK green | Link on: physical connection detected
off: no physical connection
CPU
MMC yellow | blinks at MMC access
FRCE yellow | blinks as soon as variable are forced (fixed)
SF red |blinks at system errors (hardware defect)

PWR green | CPU section is provided internal with 5V

LEDs at Above the operating mode lever there are 2 LEDs, showing the operating
connection panel state:
Label Color | Description
ST yellow | CPU is in STOP
RN green | CPU is in RUN
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Jacks and plugs

Profibus DP
master interface
PBDP/PtP

MPI interface

On the PC plug-in module the following jacks are led out:

Via the 9pin RS485 interface you link up the integrated Profibus DP master
to Profibus. The RS485 interface in PtP operation supports the serial
process connection to different source or destination systems.

The RS485 jack has the following pin occupancy:

9-pin jack
Pin Assignment

shield

M24V

RxD/TxD-P (Line B)
RTS

M5V

P5V

P24V

RxD/TxD-N (Line A)
n.c.

© 00 NO OB WN -

Note!
Please make sure to activate the terminating resistors at the bus ends!

MPI serves the connection to the process level. Here you may transfer
programs and data between the MPI participants. On delivery the MPI
address is 2.

For a serial transfer from your PC you normally need a MPI transducer.

The MPI jack has the following pin assignment:

9-pin jack

Pin Assignment

reserved (must not be connected)
M24V

RxD/TxD-P (Line B)

RTS

M5V

P5V

P24V

RxD/TxD-N (Line A)

n.c.

© 00 NO OB WN -~
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Storage media slot

Memory
management

Operating mode
switch

RN
Ok
MR

Power supply

External
power supply

As external storage medium for applications and firmware you may use a
MMC storage module (Multimedia card) or a configured MMC as MCC
memory extension card. The MCC can additionally be used as an external
storage medium.

Both VIPA storage media are pre-formatted with the PC format FAT16 and
can be accessed via a card reader.

Every CPU 51xS has an integrated work memory. During program run the
total memory is divided into 50% for program code and 50% for data.

There is the possibility to extend the total memory to its maximum by
means of a Memory Configuration Card called MCC.

Attention!

At deployment of a MMC, please regard, that it has to be preformatted with
the FAT16 file system. The VIPA memory cards are always delivered
preformatted.

With the operating mode switch you may switch the CPU between STOP
and RUN. The operating mode START-UP is driven automatically from the
CPU between STOP and RUN.

Placing the switch to Memory Reset (MRES), you request an overall reset
with following load from MMC (project or firmware update).

After the CPU 51xS slot card is installed in the PC and the communication
between PC and Ethernet component is established the DC 24V power
supply may be attached.

The CPU component of the CPU 51xS slot card can only be operated with
an external or internal DC 24V power supply. The external supply enables
the operation of the card outside of a PC res. independent from the PC
operation. Please consider for operation that the slot card is connected to
ground via its metal cover.

Note!

The CPU 51xS is to supply either externally or internally with DC 24V.
Simultaneous infeed should absolutely be avoided!

For external power supply there is a plug on slot panel with the following
pin assignment:

DC 24V =+

GND
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Internal
power supply

Battery buffer for
clock and RAM

For the internal power DC 24V supply there is a clamp on the top of the slot
card.

Please consider when connecting a DC 24V power supply that the internal
power supply hardware conditionally does not have an EMC filter for
protection against disturbances (like e.g. EN 61000-4-4 [Burst], EN 61000-
4-5 [Surge] or EN 61000-4-6 [conducted disturbance variable, inducted by
HF fields]).

Here please use an accordingly filtered supply voltage here.

The clamp has the following pin assignment:

The CPU 51xS contains an internal accumulator/battery for protecting the
RAM at a power break-down. Additionally the battery buffers the internal
clock.

The battery is directly reloaded via the integrated voltage supply by means
of a special loading electronic and guarantees a buffer of minimum 30
days.

The battery has to be error free, so that the CPU may automatically restart.

A start with a defective battery is possible, if it is manually switched to RUN
or if a MMC is plugged, which contains a valid s7prog.wld project with an
OB81 for battery fault.

If there is an error concerning the integrated battery, the CPU should be
checked. Here please contact VIPA!

2-8
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Technical Data

Order number VIPA 517-2AJ02
Type CPU 517S/DPM
Technical Data power supply

Power supply (rated value) DC 24V
Power supply (permitted range) DC 20.4...28.8V
Reverse polarity protection yes
Current consumption (no-load operation) 250mA
Current consumption (rated value) 1A

Inrush current 5A

Load and working memory

Load memory, integrated 8MB

Load memory, maximum 8MB
Work memory, integrated 2MB
Work memory, maximum 8MB
Memory divided in 50% program / 50% data yes
Memory Card Slot MMC-Card with max. 1GB
Hardware config

Number of DP master integrated 1

Status information, interrupts, diagnostics

Status display yes
Interrupts no
Process interrupt no
Diagnostic interrupt no
Command processing times

Bit instructions, min. 0.01us
Word instructions, min. 0.01us
Double integer arithmetic, min. 0.01us
Floating-point arithmetic, min. 0.06us
Timer/Counter and retentive characteristic

Number of S7 counters 2048
Number of S7 timers 2048

Data range and retentive characteristic

Number of flags 16384Byte
Number of data blocks 8190

Max. data blocks size 64KB
Max. local data size per execution level 510Byte
Blocks

Number of OBs 24
Number of FBs 8191
Number of FCs 8191
Maximum nesting depth per priority class 8
Maximum nesting depth additional within an error OB 4

Time

Real-time clock buffered yes

Clock buffered period (min.) 6 weeks
Accuracy (max. deviation per day) 10s
Number of operating hours counter 8

Clock synchronization yes
Synchronization via MPI MasterSlave
Synchronization via Ethernet (NTP) no
Address areas (I/O)

Input I/0O address area 8192Byte
Output I/0O address area 8192Byte
Input processing image maximal 8192Byte

HB145E - CPU - RE_517-2AJ02 - Rev. 10/23
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Order number VIPA 517-2AJ02
Output processing image maximal 8192Byte
Digital inputs 65536
Digital outputs 65536
Analog inputs 4096
Analog outputs 4096
Communication functions

PG/OP channel yes
Global data communication yes
Number of GD circuits, max. 16

Size of GD packets, max. 54Byte
S7 basis communication yes

S7 basis communication, user data per job 76Byte
S7 communication yes

S7 communication as server yes

S7 communication, user data per job 160Byte
Number of connections, max. 32
Functionality Sub-D interfaces

Type X2

Type of interface RS485
Connector SubD, 9-pin, female
Electrically isolated yes

MPI yes
Type X3

Type of interface RS485
Connector SubD, 9-pin, female
Electrically isolated yes

DP master yes

DP slave yes
Functionality Profibus master

PG/OP channel yes
Routing yes

S7 basis communication yes

S7 communication yes

S7 communication as Server yes
SYNC/FREEZE yes
Activation/Deactivation of DP slaves yes
DPV1 yes
Transmission speed, min. 9.6kbit/s
Transmission speed max. 12Mbit/s
Number of DP slaves, max. 32
Address range inputs, max. 1KB
Address range outputs, max. 1KB
User data inputs per slave, max. 244Byte
User data outputs per slave, max. 244Byte
Functionality Profibus Slave

PG/OP channel yes
Routing yes

S7 communication yes

S7 communication as Server yes
DPV1 yes
Transmission speed min. 9.6kbit/s
Transmission speed max. 12Mbit/s
Transfer memory inputs, max. 244Byte
Transfer memory outputs, max. 244Byte
Address areas, max. 32

User data per address area, max. 32Byte

2-10
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Order number

VIPA 517-2AJ02

Functionality PCl interfaces

Type n/a

Type of interface Ethernet 10/100Mbit
Connector PCI bus

Electrically isolated yes

PG/OP channel yes

Mechanical Data

Dimensions (WxHxD)

20mm x 106mm x 174mm

Weight 290g
Environment conditions

Operating temperature 0°Cto 60°C
Storage temperature -25°C to 70°C
Certification

UL508 certification in preparation

HB145E - CPU - RE_517-2AJ02 - Rev. 10/23
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Chapter 3 Deployment CPU 517S/DPM

Overview Main topic of this chapter is the deployment of the CPU 517S/DPM from
VIPA. Here information necessary for installation, start-up and project
engineering may be found.
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Overview

Functionality
Ethernet (LAN)
CPU component

IP address
parameter
assignment

Steps of
installation

The CPU 51xS PC plug-in card consists of an Ethernet (LAN) and a CPU
component. These communicate internally over an Ethernet connection.
For this both components are each be assigned to an IP address, which
may differ only in the Host-ID. In this way several CPU 51xS may be
operated in your PC.

The CPU component of the CPU 51xS slot card can only be operated with
an external or internal DC 24V power supply. The external supply enables
the operation of the card outside of a PC res. independent from the PC
operation. Please consider for operation that the slot card is connected to
ground via its metal cover.

The assignment of IP address parameters for the Ethernet component is
made by the Windows operating system by the Network environment

The CPU component receives its IP address parameters by the Siemens
SIMATIC manager by means of the PLC functions or a minimal project.

The addresses are not affected by an overall reset. The IP address
parameters of the CPU component are deleted by a factory reset.

» Install the CPU 51xS PC slot card at a free 32bit PCI slot
(PCI version 2.2, 32bit data/address bus, 3.3V current).

» Switch PC on.

» Install driver for the Ethernet component. This can be found at the
"ToolDemo-CD" SW900TOLA at driver/slotplc the according CPU 51xS.

» Set IP address and subnet mask for the Ethernet component of the slot
card by means of Properties of the Network environment. Here the IP
addresses may only differ in the Host-ID.

e Supply CPU component with DC 24V.

* Assign IP address parameters to the CPU component by means of
Siemens SIMATIC manager. There are the following possibilities for
assigning IP address parameters (Initialization):

- PLC functions with Edith Ethernet Node
(search PLC and assign IP address)

- Hardware project engineering with CP (Minimal project)

If the "Net" components are installed at your Siemens SIMATIC manager
the CPU 51xS is displayed as Intel(R) 8255xER PCI Adapter at the
PG/PC interface area. The CPU can online be accessed by the PG/OP
channel.

The steps are detailed described at the following pages.

3-2
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Assembly

Assembly

Eliminate possibly existing static loading, before mounting the VIPA PCI
card, by affecting a grounded metal object.

Switch your computer off and remove the power cable.

Remove the covers from your computer according to the manufacturers
instructions.

Search a free 32bit PCI slot (usually white ore beige). Please regard that
your PCI bus corresponds to the following specification:
PCI version 2.2 , 32Bit data/address bus, 3.3V voltage.

Remove one of the metal covers from a slot.

Insert the slot card, bolt the slot card with the computer case and close
the covers of your computer.

Please consider that the metal cover of the slot card is always
connected to ground and bolted with the computer case!

e e [11 Screw

w [2] Metal slot cover
e
-l

Note!

The installation should only be accomplished by experienced technical
personnel!

Slot card or PC may be damaged by an incorrect installation.
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Installation of the driver

Overview

Start-up without
external CPU
power supply

Assign IP address
parameters to the
Ethernet component

A driver is necessary for the integration of the slot card into the operating
system. The slot card driver may be found at the enclosed CD
SWO00TOLA. For start-up the power supply of the CPU component is not
for the time being necessary.

» Turn the PC on after mounting the slot card. The slot card is recognized
as a new network hardware after run-up of the PC and the appropriate
driver is requested. The driver can be found on the enclosed "ToolDemo
CD" SW900TOLA.

e Put in the CD and navigate via driver/slotplc to the directory from the
according PLC 51xS. Here the slot card driver for each relevant
operating system may be found.

« |nstall the slot card driver.

The CPU 51xS slot card is now specified to the operating system and is
listed as an additional LAN connection with the device name "Intel(R) 8255
PCI adapters". As long as the CPU component is not supplied with DC 24V
the message appears "The network cable was removed".

After installation of the driver IP address and Subnet mask can be
assigned by the properties of the network environment at any time.
Attention should be paid that the IP address of the CPU and Ethernet
component differs exclusively in the Host-ID.

Note!

More information about assigning IP addresses may be found at
"Guidelines for IP address assignment" at the following pages.

Please consider the guidelines, since incorrect adjusted IP address
parameters may have effects on the whole firm net.

3-4
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Guidelines for IP address assignment

Overview

Net-ID
Host-ID

The CPU 51xS slot card consists of a CPU and a Ethernet component that
communicate via a TCP-based point-to-point connection. To enable this,
CPU and Ethernet component each have an alterable IP address that may
only differ in the Host-ID.

For start-up and for further comprehension, a thorough knowledge of Net-
ID, Host-ID and Subnet-ID are assumed. In the following detailed
information about this can be found.

PC

—] CPU 51xS

CPU Siemens SIMATIC
L

) Manager
IP-Adr: Net-ID.Host-ID¢p

Subnet
I Ethernet communication

Ethernet

IP-Adr: Net-ID.Host-IDgy,
Subnet

— —

f—

Windows driver

i

|

I PCl communication

PCI slot

If you want to install several CPU 51xS in one PC, every CPU 51xS plug-in
card needs an own Net-ID.

The following text describes the approach for the assignment of IP
addresses together with Net-ID and Host-ID.

Every IP address is a combination of a Net-ID and a Host-ID.

The Network-ID identifies a network res. a network controller that
administrates the network.

The Host-ID marks the network connections of a participant (host) to this
network.

Note!
Never choose an IP address with Host-ID=0 or Host-ID=maximum!

(e.g. for class B with Subnet Mask = 255.255.0.0, the "172.16.0.0" is
reserved and the "172.16.255.255" is occupied as local broadcast address
for this network.)
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Subnet-Mask

Address classes

Private IP networks

The Host-ID can be further divided into a Subnet-ID and a new Host-ID by
using an bit for bit AND assignment with the Subnet-Mask.

The area of the original Host-ID that is overwritten by 1 of the Subnet-Mask
becomes the Subnet-ID, the rest is the new Host-ID.

Subnet-Mask binary all "1" | binary all "0"
IPv4 address Net-I1D Host-ID
Subnet-Mask and IPv4 address Net-ID Subnet-ID | new Host-ID

A TCP-based communication via point-to-point, hub or switch connection is
only possible between stations with identical Network-ID and Subnet-ID!
Different area must be connected with a router.

The Subnet-Mask allows you to sort the resources after your needs. This
means e.g. that every department gets an own subnet and thus does not
interfere another department.

For IPv4 addresses there are five address formats (class A to class E) that
are all of a length of 4byte = 32bit.

Class A |0 |Network-ID Host-ID (24 bit)
(1+7 bit)
Class B [10 |Network-ID (2+14 bit) | Host-ID (16 bit)
Class C [110 [Network-ID (3+21 bit) | Host-ID (8 bit)
ClassD [1110 [Multicast group
ClassE [11110 |Reserved

The classes A, B and C are used for individual addresses, class D for
multicast addresses and class E is reserved for special purposes.

The address formats of the classes A, B, C are only differing in the length
of Network-ID and Host-ID.

To build up private IP-Networks within the internet, RFC1597/1918
reserves the following address areas:

Network | Start IP End IP Standard Subnet Mask
class

A 10.0.0.0 10.255.255.255 255.0.0.0

B 172.16.0.0 |172.31.255.255 255.255.0.0

C 192.168.0.0 |192.168.255.255 |255.255.255.0

(The Host-ID is underlined.)

These addresses can be used as net-ID by several organizations without
causing conflicts, for these IP addresses are neither assigned in the
internet nor are routed in the internet.

Reserved Some Host-IDs are reserved for special purposes.

Host-lds Host-ID =0 Identifier of this network, reserved!
Host-ID = maximum (binary complete 1) | Broadcast address of this network
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Example network In common, your complete network consists of a PC with (at least) one
planning for start-up  network card and one or more CPU 51xS plug-in cards that are also each
listed as network card with the CPU as single participant:

In this example for Ethernet and CPU component IP addresses from
private class C net were selected. Using the Subnet mask 255.255.255.0
256 different networks with 254 host addresses each are available

CPU 51xS
LAN with recomm. IP/Mask
CPU with example IP/Mask

192.168.201.2 / 255.255.255.0
192.168.201.3 / 255.255.255.0

I— Host-ID (chosen from 1...254)

Net-ID Class C private area
(3rd Byte freely chosen)

To enable the PC to connect the CPU 51xS plug-in cards and the
subordinated CPUs without using a router table, you have to assign an
individual Net-ID for every card!

PC

e.g.

Network card (IP/Mask from DHCP-Server)

192.168.1.2 / 255.255.255.0

1. CPU 51xS

LAN with example IP/Mask  192.168.201.2 / 255.255.255.0
CPU with example IP/Mask 192.168.201.3 / 255.255.255.0

2. CPU 51xS

LAN with example IP/Mask  192.168.202.2 / 255.255.255.0
CPU with example IP/Mask 192.168.202.3 / 255.255.255.0

3. CPU 51xS

LAN with example IP/Mask  192.168.203.2 / 255.255.255.0
CPU with example IP/Mask 192.168.203.3 / 255.255.255.0

HB145E - CPU - RE_517-2AJ02 - Rev. 10/23
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Connect power supply

Connect power
supply

External
power supply

After the CPU 51xS slot card is installed in the PC and the communication
between PC and Ethernet component is established the DC 24V power
supply may be attached.

The CPU component of the CPU 51xS slot card can only be operated with
an external or internal DC 24V power supply. The external supply enables
the operation of the card outside of a PC res. independent from the PC
operation. Please consider for operation that the slot card is connected to
ground via its metal cover.

Note!

The CPU 51xS is to supply either externally or internally with DC 24V.
Simultaneous infeed should absolutely be avoided!

For external power supply there is a plug on slot panel with the following
pin assignment:

DC 24V - +
=

GND ——

For the cabling of power supply of a CPU, a green plug with CageClamp
technology is deployed.

The connection clamp is realized as plug that may be clipped off carefully
if it is still wired.

Here wires with a cross-section of 0.08mm? to 2.5mm? may be connected.
You can use flexible wires without end cases as well as stiff wires.

[11 Test point for 2mm test tip
[2] Locking (orange) for screwdriver
[3] Round opening for wires

The picture on the left side shows the cabling step by step from top view.

« For cabling you push the locking vertical to the inside with a suiting
screwdriver and hold the screwdriver in this position.

« Insert the insulation striped wire into the round opening. You may use
wires with a cross-section from 0.08mm? to 2.5mm?.

» By removing the screwdriver the wire is connected safely with the plug
connector via a spring.

3-8
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Internal For the internal power DC 24V supply there is a clamp on the top of the slot
power supply card.
Please consider when connecting a DC 24V power supply that the internal
power supply hardware conditionally does not have an EMC filter for
protection against disturbances (like e.g. EN 61000-4-4 [Burst], EN 61000-
4-5 [Surge] or EN 61000-4-6 [conducted disturbance variable, inducted by
HF fields]).

Here please use an accordingly filtered supply voltage here.

The clamp has the following pin assignment:
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Initialization of the CPU component

Overview

Possibilities for
Initialization

Requirements

The CPU 51xS slot card consists of a CPU and an Ethernet component.
For communication both components own an IP address, which may differ
only in the Host-ID. For online access to the CPU component valid IP
address parameters have to be assigned to this by means of the Siemens
SIMATIC manager. This is called "initialization".

The initialization of the Ethernet component takes place by the properties
of the network environment of your operating system, as described above.

There are the following possibilities for assignment of |IP address
parameters:

» PLC functions with Edith Ethernet Node
(projecting tool and slot card in the same PC)

» Hardware project engineering with CP (Minimal project)

PC
SIMATIC Manager from Siemens
PG/PC interface: CPU 51xS
Intel(R) 8255xER CPU (virtual CP)
Setting via:
- Minimal project CP 343-1 ) | Subnet: 255.255.255.0
- PLC functions —15 | ip-Adr: 192 . 168 . 201 . 3

PG/OP channel | ‘

Subnet: 255.255.255.0
IP-Addr.: 192.168.201.3 Net-ID Host—IDCPU

Precondition:
PG/OP Net-ID : equal
Ethernet Host-ID: not equal

LAN connection

Subnet: 255.255.255.0

I
Setting via —» | IP-Adr.: ‘192 . 168 . 201 . 2
PCI

Windows driver
Intel(R) 8255xER <) |

Net-ID Host—IDEth

For the hardware configuration the following software is necessary:

» Siemens SIMATIC manager V. 5.1 and SIMATIC NET or Siemens
SIMATIC manager V. 5.2 and SP1

3-10
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Initialization via The initialization by PLC function can only be established if Siemens
PLC functions SIMATIC manager and CPU 51xS slot card are at the same PC.

The initialization takes place after the following proceeding:

» Start the Siemens SIMATIC manager.

» Set via Options > Set PG/PC Interface the Access Path to
"Intel(R) 8255xER".

e Open with PLC > Edith Ethernet Node the dialog window for
"initialization" of a station.

» Use the [Browse] button to determine the CPU components via MAC
address.

Edit Ethernet Nade x|

- Ethemet nod

Nodes accessible anling

MAC address: || Brawse:

—Set IP configuration

' 1se IP parameters

Gateway

IP* add
ki & Do not use router
Subnet mask: = Use router
Addiess: I

© Obtain |P address from a DHCP server
i~ Identified by

61 Client (07 1 WAL address 1 Device rame

CliertiD: |

Assian [P Configuration,

~ Agsigh device nam

Device name: Assign Name
~ Reset to factory setting:
Fiesst
Close | Help

* Choose the determined module and click to [OK].

» Set the IP configuration by entering IP address, subnet mask and net
transition. In addition an IP address may be received from a DHCP
server. For this depending upon the selected option the MAC address,
device name or the Client ID which can be entered here is to be
conveyed to the DHCP server. The Client-ID is a character sequence
from maximally 63 characters.

Here the following indications may be used: Dash "-", 0-9, A-z, A-Z

» Confirm your settings by button [Assign IP Configuration]

Direct after the assignment the CPU component may be reached by the
Siemens SIMATIC manager by means of these IP address parameters.
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Initialization via
minimal project

If the CPU 51xS slot card and the Siemens SIMATIC manager are not at
the same PC, the CPU component may get its IP address parameters from
a minimal project for CPU with CP.

The Project may be transferred to the CPU 51xS slot card by MPI or by
means of a MMC memory card.

The initialization by means of a minimal project takes place after the
following proceeding:

» Start the Siemens SIMATIC manager and create a new project.

* Add a new System 300 station via Insert > Station > SIMATIC 300-
Station.

» Activate the station "SIMATIC 300" and open the hardware configurator
by clicking on "Hardware".

» Engineer a rack (SIMATIC 300 \ Rack-300 \ Profile rail).

» For the SPEED7-CPUs are configured as CPU 318-2, choose the CPU
318-2 with the order no. 6ES7 318-2AJ00-0ABO0 V3.0 from the hardware
catalog. You'll find this at SIMATIC 300 \ CPU 300 \ CPU 318-2.

» Project engineering Ethernet PG/OP channel as CP 343-1 (343-1EX11).

» Project engineering and networking Ethernet-CP 343 and DP master as
CP 343-1 (343-1EX11) respectively CP 342-5 (342-5DA02 V5.0).

iz HW Confiig - [Station 1 (Configuration) — speed?] ) =&l x|
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Type the wanted IP address and subnet mask into the dialog window
and connect the CP with "Ethernet".

Properties - Ethernet interface CP 343-1 (R0/54) x|

General  Parameters |
I Bet MAL sddress / use 150 protocol

MAC address

¥ [P protacal s beng us

1P address: 17216129103
& Donot use router
Subnet mask: 255.265.224.0
€ Use router
Address:
Ubnel

Save and compile your project.
Transfer your project via MPI or MMC into your CPU.

Project transfer There are 2 possibilities for the transfer of your project into the CPU:

Transfer via MPI

Transfer via MPI
Transfer via storage card at deployment of a card reader

Change to the Siemens SIMATIC manager.
Choose Options > Set PG/PC interface

- A dialog window opens where you may configure the MPI interface
you want to use.

Choose the "PC Adapter (MPI)" from the selection list; where
appropriate you have to add this first. Click on [Properties].

Select the wanted COM port in the register "Local Port" and set the
transfer rate 38400bit/s.

Connect your PC via MPI with your CPU and transfer your project.

Transfer via MMC As external storage medium a MMC (Memory Card) is employed. The
MMC is available at VIPA preformatted with the FAT16 PC file system.

Create a new wid file via File > Memory Card file > New and use the
mouse to drag the system data case &3 into the window of the wid file.

Copy the wid file with the help of a reading device to the MMC and
rename the file to STPROG.WLD.

Insert the MMC in your CPU and execute an overall reset. This causes a
transfer of the data from the MMC into the battery-buffered RAM of the
CPU.

Note!

More information about transfer methods may be found in the chapter
"Project transfer".
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Internal access to PG/OP channel

Overview

Access to
PG/OP channel

Requirements

Approach

Every CPU 51xS has an integrated Ethernet-PG/OP channel. Only in
installed condition you have access via the PG/OP channel to your CPU.
Here you may program, remote control or show the integrated web page.
There are maximum 4 channels.

If the conditions for communication are fulfilled, the slot card may be
accesses by the PG/PC interface as "Intel(R) 8255xER" for project transfer
and diagnostics.

» CPU 51xS slot card and Siemens SIMATIC manager are installed at the
same PC.

» Ethernet and CPU component are assigned each to one IP address that
may only differ in the Host-ID.

» Siemens SIMATIC manager starting with version V. 5.1 and SIMATIC
NET respectively V. 5.2 and SP1 are installed for hardware configu-
ration.

Start the Siemens SIMATIC manager.
» Set Options > PG/PC Interface... to: "Intel(R) 8255xER"
The PG/OP channel may online be accessed, now.

PC

SlMATlC Manager from Siemens
PG/PC interface:

CPU 51xS

Intel(R) 8255xER CPU (virtual CP)
Setting via:
- Minimal project CP 343-1 L) | Subnet: 255.255.255.0
- PLC functions '_E—> IP-Adr.: ‘192 . 168 . 201 \ 3
PG/OP channel ‘
Subnet: 255.255.255.0
IP-Addr.: 192.168.201.3 Net-ID Host-ID 5,
Precondition:
PG/OP Net-ID : equal
Ethernet Host-ID: not equal
LAN connection
L | Subnet: 255.255.255.0
Setting via 61 E—} IP-Adr.: ‘192 . 168 . 201 . 2
Windows driver
Intel(R) 8255xER | =l |
Net-1D Host—IDEth

3-14
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External access to PG/OP channel via routing

Overview

You may access the CPU 51xS from an external PC via Ethernet. The
following preconditions must be fulfilled:

» The routing is activated on the PC with the CPU 51xS

» The route is entered at the CPU 51xS via a CP343 hardware
configuration with the following parameters:

- Destination router: IP address of the Ethernet component IPgy, of

the CPU 51xS

» The route is entered at the external PC with the following parameters:
- Destination-IP: Net-ID of the Ethernet component of the CPU 51xS

- IP-Mask: subnet mask of the CPU 51xS (default: 255.255.255.0)

- Gateway: IP address of the PCs IPpc with the CPU 51xS at the

home network

CP343 HW conf.
Properties

Router: (Net-ID,.Host-IDg,,)

Routing active

Route Add

Dest.-IP: Net-ID,.0
IP-Mask: 255.255.255.0
Gateway: IPp¢,

PC, PC,
CPU 51xS, CPU 51xS,
CPU part CPU part Route Application
IPgpus (Net-ID,.Host-IDgpy) IPgpus (Net-ID, Host-IDgpy) CPU51xS
I
1 Net-D, 3 Netp, L
Ethernet part Ethernet part } | . www
IPgys (Net-ID,.Host-IDg,,,) 1Py (Net-1D,.Host-IDgyy,)
Net 1 T o, Net2 T ™ I ™
10/100 10/100
IPec IPec,
“» <>
Home net
Attention!

Default
Gateway

Only a trained system administrator should execute changes at the network

neighborhood for this may cause conflicts with the company network!

The employment with Windows 9x res. Windows XP Home is not
recommended and not described.

HB145E - CPU - RE_517-2AJ02 - Rev. 10/23
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Activate routing The following text describes the steps of configuration. More detailed
information especially to the operating system specific routing is to find in
the documentation of the operating system.

Activation at Windows NT4 / 2000sener / 2003server

The activation of the routing happens in the "Network neighborhood
properties" at the properties of the TCP/IP protocol.

Activation at Windows XPp,gtessional / 2000pofessional
For the activation, an entry into the registry file is required like illustrated

below:
£ Registry Editor
File Edit ‘iew Favorites Help
"1:| Tapisry ;I Mame Tvpe | Duata :l
- Tepip [ab]Hostname REG_SZ £500
-~ Erum IPEnableRouter REG_DWORD € 1=00000001 (173
D Linkage st [ab]yameServer REG_SZ J
Elﬁ Parameters [ab]ry Damain REG_SZ
- B Adapters o] 3By Hostname REG 52 c -
4] | » 1 | »
|I'~'1~;.-' ComputertHEEY _LonZAL MACHIMEYSYSTEMCurrentControlSett Services) TepiptParameters Y

After a reboot, the routing is active.

Enter route The entry of a route happens exclusively via the command console of the
operating system by using the "route" command. The following parameters
are required:

route ADD <Destination-IP> MASK <|P-Mask> <Gateway> METRIC <Metric>
IF <IF>

with

ADD: Command for adding a route

Dest.-IP:  IP address of the network (Net-ID) of the CPU 51xS
[P-Mask: Subnet mask of the net of the CPU 51xS

Gateway: |IP address of the destination computer at the home network
with the plugged CPU 51xS

Metric: (optional) Price value for a destination
IF: (optional) Preset interface or best alternate interface

route PRINT lists all entered routes
route DELETE <Destination-IP> deletes the entry
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Example: The following constellation is present and you want to access the CPU via
PC:
PC, PC,
CPU 51xS,
CPU part
Py, 192.168.201.5
1 Net-ID,
Ethernet part
P, 192.168.201.3
TP TP
Net 1 A 10/100 10/100
IPoc, 172.16.128.15 IPec, 172.16.128.29
Default
Home net Gateway

» Activate the routing at PC1 like described above.

» Start the hardware configurator from Siemens and configure a system
with CP 343.

e Enter the IP address 192.168.201.5 and the subnet mask
255.255.255.0 in "Properties Ethernet interface".

» Choose the function “Use router” at "Parameter", enter the |IP address
192.168.201.3 of the Ethernet part of the CPU 51xS as "Gateway" and
transfer your project.

» Start the command console at PC2 and enter the following statement:
route add 192.168. 201. 0 mask 255. 255.255.0 172.16.128. 15

Now you may access the CPU from PC2 via PC1. You may test the
connection with the command pi ng 192. 168. 201. 5.
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Access to the integrated web page

Access to the The PG/OP channel provides a web page that you may access via an
web page internet browser. The web page contains information about firmware
versions, current cycle times etc.

The current content of the web page is stored on MMC by means of the
MMC-Cmd WEBPAGE. More information may be found at "MMC-Cmd -
Auto commands".

Requirements A PG/OP channel should be established between PC with Internet browser
and CPU 51xS slot card. This may be tested by Ping to the IP address of
the CPU component.

Web page The access takes place via the IP address of the CPU component. The
_ web page only serves for information output. The monitored values are not
- - R A D
alterable.
e | m.mﬁs\.zu
IP CPU part
CPU W TH ETHERNET- PG OP
Sl ot 100
VI PA 517-2AJ02 V3.5.1.4 Px000117. pkg, Order no., firmware version, package,
SERI ALNUMBER 18519 serial no.
SUPPORTDATA : Information for support:

PRODUCT V3514, HARDWARE V0110, 5448D- V10 |,

Hx000062. 100 , Bx000227 V6514, Ax000086

V1200, fx000007.w d V1140,

Fl ashFi | eSystem : V102

Menorysi zes (Bytes): LoadMem : 8388608,

Wor kMenCode : 1048576, WorkMenData : 1048576

OnBoar dEt hernet : MacAddress : 0020d5774857, Ethernet PG/OP: Addresses
| P- Address : 192.168.201.3, Subnet Mask :

255. 255. 255. 0, Gateway : 192.168.201. 3

Cpu state : Stop CPU status
Functi onRS485 X2/ COML: MPI RS485 function
Functi onRS485 X3/ COMR2: DPM async

Cycletine [m croseconds]: CPU cycle time:

nm n=426 cur=492 ave=522 max=912
ArmLoad [percent] : cur=0, nmax=83
Power Cycl eHxRetries : 80, 0, 0, 0, O

min= minimal

cur= current

max= maximal

Additional CPU components:

Sl ot 201 Slot 201 (DP master):
VI PA 542-1DP00 V3.2.6 Px000119. pkg Name, firmware version, package
SUPPORTDATA : PRODUCT V3260, Information for support:

BB000554 V5260, AB000120 V4170,

Modul eType CB2C0010

Cycletine [mcroseconds] :

m n=65535000 cur=0 ave=0 max=0 cnt =0

BaudRat e Read Mbdel , BaudRate Wite Mdel Standard bus
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Project engineering

Overview

Preconditions

Install hardware
configurator from
Siemens

The project engineering of CPU and DP master takes place in the Siemens
SIMATIC manager. The CPU 51xS slot card may online be accessed for
parameterization by PLC functions via Ethernet respectively MPI/Profibus.

In addition, the project may be transferred by a MMC memory card to the
PC slot card.

On delivery the CPU 51xS slot card has the MPI address 2.

For the hardware configuration of the CPU and the project engineering of
the integrated Profibus DP master of the CPU, the following preconditions
must be met:

» Siemens SIMATIC manager starting with version V. 5.1 and SIMATIC
NET respectively V. 5.2 and SP1 are installed for hardware configu-
ration.

* A communication connection to the slot card is established

» At usage of Profibus DP slaves of the Systems 100V, 200V and 300V
from VIPA: GSD files are included in the hardware configurator.

For the project engineering of the CPU and the Profibus DP master, a
thorough knowledge of the SIMATIC manager and the hardware
configurator from Siemens are assumed!

The hardware configurator is part of the Siemens SIMATIC manager. It
serves the project engineering. The modules that you may configure here
are to find in the hardware catalog.

For the deployment of Profibus slaves of the Systems 100V, 200V and

300V from VIPA, the import of the modules to the hardware catalog via the
GSD-files from VIPA is necessary.
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Fast introduction

Standard

bus

| Slot_ |
1

Module

2 | CPU318-2

X2
X1

DP
MPI/DP

3

343-1EX11

(Ethernet-PG/OP)

342-5DA02 V5.0

virtual DP master for CPU

(only for VIPA specific
object properties)

(100) VIPA
. SPEEDbus

VIPA_SPEEDBUS

CPU:
Addr.: 100

[Slot__[Order no.

o CPU 51xS at slot 100

Object properties:
Function RS485

The project engineering of the CPU 51xS takes place at the Siemens
hardware configurator and is divided into the following parts:

Project engineering as CPU 318-2
(318-2AJ00-0AB00 V3.0)

Project engineering Ethernet PG/OP channel as CP 343-1 (343-1EX11)

Project engineering CPU 51xS as DP slaves in a virtual DP master
CP 342-5 (342-5DA02 V5.0).

To be compatible with the Siemens SIMATIC manager the following steps
should be executed:

Start the hardware configurator from Siemens.

Configure the Siemens CPU 318-2 (6ES7 318-2AJ00-0AB0/V3.0).
Configure the internal DP master of your CPU via the internal DP
master of the CPU 318-2. Leave MPI/DP of the CPU 318-2 in MPI
mode. The Profibus mode is not supported.

For the internal Ethernet PG/OP channel you have to configure a
Siemens CP 343-1 (343-1EX11).

Configure as last module the Siemens DP master 342-5 (342-5DA02
V5.0). Link the DP master and switch it to DP master operating mode.

To this master system you assign the CPU as "VIPA_SPEEDBUS"
slave. Here the Profibus address corresponds to the slot no. Beginning
with 100 for the CPU. Place at slot 0 of every slave the assigned
module and alter the parameters if needed.

In the following these steps are more described.

3-20
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Approach The CPU 51xS has to be configured analog to a CPU318-2 from Siemens
with Profibus DP master and a plugged Ethernet-CP CP343-1.

» Start the hardware configurator and create a new project System 300.
» Add a profile rail from the hardware catalog.

* You reach the CPU with Profibus master in the hardware catalog at:
Si mat i ¢c300/ CPU- 300/ CPU318- 2DP/ 6ES7 318- 2AJ00- 0ABO

* Insert the CPU 318-2DP (6ES7 318-2AJ00-0AB0/V3.0).
» Enter a Profibus address for the master (e.g. 2)

* Click on DP and set the operating mode “DP Master” in the Object
properties. Confirm the settings by [OK].

Configuration of Configure representatively for the CPU component a CP 343-1.
the CPU as This may be found in the hardware catalog at:
CP 343-1 Si mat i ¢300/ CP- 300/ I ndustri al Ethernet.

» Add the CP 343-1 (343-1EX11-0XEO) at slot 4.

» Click on the CP and enter the according IP address and subnet mask at
Object properties. Enter the IP address parameters favored or assigned
at initialization.

Please note that the IP address may differ exclusively in the host ID from
the IP address of the Ethernet component.

The CPU component of the CPU 51xS slot card may be accessed by this
address by means of the PLC functions.
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Configure DP
master system

Include
DP slaves

Transfer project

For the project engineering of the DP master system, you have to execute
the following steps:

Right click on DP and choose "Add Master System ".

Create a new Profibus subnet with NEW. This subnet allows you to
configure your Profibus slave modules.

For the project engineering of Profibus DP slaves, choose the according
Profibus DP slave from the hardware catalog and move it to the subnet
of your master.

Assign a valid Profibus address to the DP slave.

Include the modules of the DP slave system in plugged sequence and
assign valid addresses to the modules.

Parameterize the modules if needed.

The following illustration shows the project engineering. Additionally the
picture includes a VIPA Profibus DP slave as example:

Slot Module
1

2 CPU 318-2

BES7 318-2AJ00-0AB0 V3.0 —— o DP
él MPI/DP DP master system
6GK7 343-1EX20-0XE0O —— 4 CP 343-1 ‘
5
6

g

The CPU 51xS slot card may online be accessed for parameterization by
PLC functions via Ethernet respectively MPI/Profibus.

In addition, the project may be transferred by a MMC memory card to the
PC slot card.

More information about transferring a project can be found at "Project
transfer" below.

During start-up the Profibus project is forwarded to the Profibus master.
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CPU parameterization

Overview

Parameterization
via Siemens
CPU 318-2DP

Except of the VIPA specific CPU parameters the CPU parameterization
takes place in the parameter dialog of the CPU 318-2DP.

The VIPA specific CPU parameters like the RS485 interface behavior and
the synchronization between CPU and DP master can be configured in the
SPEED-Bus CPU parameter dialog.

For the SPEED7-CPUs are configured in the hardware configurator from
Siemens as Siemens CPU 318-2DP you may adjust the parameters for the
SPEED7 CPUs at the hardware configuration at "Properties” of the CPU
318-2DP.

Via a double-click on the CPU 318-2DP the parameter window of the CPU
can be archived. Using the registers you get access to all parameters of
the CPU.

rl4|-|w'l:nnfii;[ [Station ( peed7] =18 x|
E“] Station  Edit  Ins ons  Window H°I|: = |
=
D[i]3-(2 (5 _J /e sl [ % x 2] vl
| Eind: | ant] e
x D
Profile: I Standard j
Time-of-Day Interupts | Cyclic Interrupts I Diagnostics/Clock | Protection I
General | Startup I CycledClack Meman I Retentive Memary I Memarny I Intermipts U . L?:llMATlC 300 -
i c7
Short Description: CPU 318-2 -3 CP-300
ork memory 256KE; 0.3ms/1000 instructions; MPl+ DP connector [DF'_I H D C] CPU-300
:l CPU 32

4

=] o R

Siat| [§ Module

CPU 312 IFM

CPU 312C

CPU 313

CPU 313C

CPU 33C-2DP
CPU 313C-2 PP
CPL 314

CPU 314 IFM

CPU 314C-2 DP
CPU 314C-2 PP
CPU 315

CPU 315-2 0P
CPU 35F-2DP
CPU 316

CPU 316-2 DF
CPU 3172

CPU 317-2 PN/DP
CPU 317F-2

CPU 318-2
D BEST 318-24]00-0481

eceive capability for direct data exchange; constant bus cycle time;

mazter or DF zlave]: multi-ier configuration up to 32 modules; send and
I
routing; 57 Communication [loadable FBs/FCs); firmware %3.0 j

H-E-E-E

Order Ma./ firmware BESY 318-24J00-04B0 / V3.0

[

M ame:

[+

Flant dezignation: I

o [T Bl - G- B - - - - - R - - D

TTHL

Cancel |

'Wusuuuuuuuuuuuuuuuuuu

@@ CPUNT

1 (771 Chd 300

=

Press F1 to get Help.

Setting IP address
and subnet mask
of the CPU

BESY 318-24]00-04B0 j |

wiork memany 256K ; 0. 3me/1 000

instructions; MPl+ DP connector [DF
Icha

master or DF slave]; multi-tier

IP address and subnet mask are entered via the properties of the
integrated CP 343-1.
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Supported
parameters

General

Short description

Order No. /
Firmware

Name

Plant designation

Comment
Startup

Startup when
expected/actual
configuration differs

Monitoring time for
ready message by
modules [100ms]

Monitoring time for
transfer of
parameters to
modules [100ms]

The CPU does not evaluate each parameter, which may be set at the
hardware configuration.

The following parameters are supported by the CPU at this time:

Since every CPU 51xS from VIPA is configured as CPU 318-2AJ00 from
Siemens, here the short description CPU 318-2 stands.

Order number and firmware are identical to the details in the "hardware
catalog" window.

The Name field provides the short description of the CPU. If you change
the name the new name appears in the Siemens SIMATIC manager.

Here is the possibility to specify a plant designation for the CPU. This plant
designation identifies parts of the plant according to their function. This has
a hierarchical structure and confirms to IEC 1346-1.

In this field information about the module may be entered.

If the checkbox for "Startup when expected/actual configuration differ" is
deselected and at least one module is not located at its configured slot or if
another type of module is inserted there instead, then the CPU switches to
STOP mode.

If the checkbox for "Startup when expected/actual configuration differ" is
selected, then the CPU starts even if there are modules not located in their
configured slots of if another type of module is inserted there instead, such
as during an initial system start-up.

This operation specifies the maximum time for the ready message of every
configured module after PowerON. If the modules do not send a ready
message to the CPU by the time the monitoring time has expired, the
actual configuration becomes unequal to the preset configuration.

The maximum time for the transfer of parameters to parameterizable
modules. If not every module has been assigned parameters by the time
this monitoring time has expired; the actual configuration becomes unequal
to the preset configuration.
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Cycle/Clock
memory

Update OB1
process image
cyclically

Scan cycle
monitoring time

Minimum scan
cycle time

Scan cycle load
from Communi-
cation

Size of the process
image input/output
area

0B85 call up at I/0O
access error

Clock memory

Activate the checkbox for cyclic updates of the OB1 process image.
Updating increases the cycle time.

Here the scan cycle monitoring time in milliseconds may be set. If the scan
cycle time exceeds the scan cycle monitoring time, the CPU enters the
STOP mode. Possible reasons for exceeding the time are:

» Communication processes
» a series of interrupt events
e an error in the CPU program

The minimum scan cycle time specifies the time interval, in which the CPU
program is called.

If the scan cycle time is less than the specified minimum scan cycle time,
the CPU waits until the minimum scan cycle time is reached.

Using this parameter you can control the duration of communication
processes, which always extend the scan cycle time so it does not exceed
a specified length.

If there are no additional asynchronous events, the scan cycle time of OB1
is increased by following factor:

100
100 - cycle load from communication %

If the cycle load from communication is set to 50%, the scan cycle time of
OB 1 can be doubled. At the same time, the scan cycle time of OB 1 is still
being influenced by asynchronous events (e.g. process interrupts) as well.

Here the size of the process image max. 2048 for the input/output
periphery may be fixed.

The preset reaction of the CPU may be changed to an I/O access error that
occurs during the update of the process image by the system.

Each CPU 51xS from VIPA is preset such that OB 85 is not called if an I/O
access error occurs and no entry is made in the diagnostic buffer either.

Activate the check box if you want to use clock memory and enter the
number of the memory byte.

Note!
The selected memory byte cannot be used for temporary data storage.
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Retentive Memory

Number of Memory
Bytes from MBO

Number of S7
Timers from TO

Number of S7
Counters from CO

Areas

Memory

Local data
(priority classes)

Interrupts

Priority

Time-of-day
interrupts

Priority

Active

Execution

Start date / time

Process image
partition

Enter the number of retentive memory bytes from memory byte 0 onwards.

Enter the number of retentive S7 timers from TO onwards.

Enter the number of retentive S7 counter from CO onwards.

Since with every VIPA CPU 51xS each data block is remanent stored, the
settings at Areas are non-relevant and they are ignored.

In these fields you may define the number of local data (temporary data)
for the priority classes 1 to 29.

Here the priorities may be specified according to which the hardware
interrupt OBs are processed (hardware interrupt, time-delay interrupt,
async. error interrupts). Interrupts for DPV1 are not supported.

With priority "0" the corresponding OB is deactivated. Please regard that
this is not supported by each OB.

Here the priorities may be specified according to which the time-of-day
interrupt is processed.

With priority "0" the corresponding OB is deactivated.

Activate the check box of the time-of-day interrupt OBs if these are to be
automatically started on complete restart.

Select how often the interrupts are to be triggered. Intervals ranging from
every minute to yearly are available. The intervals apply to the settings
made for start date and time.

Enter date and time of the first execution of the time-of-day interrupt.

This is not supported.
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Cyclic interrupts

Priority

Execution

Phase offset

Process image
partition

Diagnostics/Clock

Report cause of
STOP

Number of
messages in the
diagnostics buffer

Synchronization
type

Time interval

Correction factor

Here the priorities may be specified according to which the corresponding
cyclic interrupt is processed. With priority "0" the corresponding interrupt is
deactivated.

Enter the time intervals in ms, in which the watchdog interrupt OBs should
be processed. The start time for the clock is when the operating mode
switch is moved from STOP to RUN.

Enter the delay time in ms for current execution for the watch dog interrupt.
This should be performed if several watchdog interrupts are enabled.
Phase offset allows to distribute processing time for watchdog interrupts
across the cycle.

Is not supported.

Activate this parameter, if the CPU should report the cause of STOP to PG
respectively OP on transition to STOP.

Here the number of diagnostics are displayed, which may be stored in the
diagnostics buffer (circular buffer).

You can specify whether the CPU clock should be used to synchronize
other clocks or not.

- as slave: The clock is synchronized by another clock.
- as master: The clock synchronizes other clocks as master.
- none: There is no synchronization

Select the time intervals within which the synchronization is to be carried
out.

Lose or gain in the clock time may be compensated within a 24 hour period
by means of the correction factor in ms. If the clock is 1s slow after 24
hours, you have to specify a correction factor of "+1000" ms.
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Protection

Level of protection

Parameter for DP

General
Short description
Order no.

Name

Interface
Properties
Comment
Addresses

Diagnostics

Operating mode

Configuration

Clock

Here 1 of 3 protection levels may be set to protect the CPU from
unauthorized access.

Protection level 1 (default setting):

* No password adjustable, no restrictions
Protection level 2 with password:

» Authorized users: read and write access

» Unauthorized user: read access only
Protection level 3:

» Authorized users: read and write access

» Unauthorized user: no read and write access

The properties dialog of the Profibus part is opened via a double click to
the sub module DP.

Here the short description "DP" for Profibus DP is specified.
Nothing is shown here.

Here "DP" is shown. If you change the name, the new name appears in the
Siemens SIMATIC manager.

The Profibus address is shown here.
With this button the properties of the Profibus DP interface may be preset.

You can enter the purpose of the DP master in this box.

A diagnostics address for Profibus DP is to be preset here. In the case of
an error the CPU is informed via this address.

Here the operating mode of the Profibus part may be preset. More may be
found at chapter "Deployment CPU with Profibus".

Within the operating mode "DP-Slave" you may configure your slave
system. More may be found at chapter "Deployment CPU with Profibus".

These parameters are not supported.
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Parameter for
MPI/DP

General

Short description

Order no.

Name

Type

Interface

Properties

Comment

Addresses

Diagnostics

Operating mode,
Configuration,
Clock

The properties dialog of the MPI interface is opened via a double click to
the sub module MPI/DP.

Here the short description "MPI/DP" for the MPI interface is specified.
Nothing is shown here.

At Name "MPI/DP" for the MPI interface is shown. If you change the name,
the new name appears in the Siemens SIMATIC manager.

Please regard only the type "MPI" is supported by the VIPA CPU 51xS.
Here the MPI address is shown.
With this button the properties of the MPI interface may be preset.

You can enter the purpose of the MPI interface in this box.

A diagnostics address for the MPI interface is to be preset here. In the
case of an error the CPU is informed via this address.

These parameters are not supported.
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VIPA

specific

parameter via

SPEED7 CPU
Approach
Standard bus
| Slot_ | Module
1
| 2 [cpusis-2
X2 [ DP
X1 [ MPI/DP
3
343-1EX11
(Ethernet-PG/OP)
342-5DA02 V5.0

virtual DP master for CPU
(only for VIPA specific

object p

roperties)

(100) VIPA
-~ SPEEDbuS

VIPA_SPEEDBUS

=

Order no.
CPU 51xS at slot 100,

Object properties:
Function RS485

Here the following parameters may be accessed:

* Function RS485 (Synchronization DP master and CPU)
» Token Watch

* Number remanence flag

» Priority OB 28, OB 29, OB 33, OB 34

» Execution OB 33, OB 34

* Phase offset OB 33, OB 34

Via a hardware configuration you may configure the behavior of the
synchronization between CPU and DP master using the parameter
"Function RS485" of the object properties. Via a double-click on the
inserted CPU 51xS at SPEED-Bus the parameter window of the SPEED7
CPU can be achieved.

Configure your SPEED7 system as shown above. After configuration
the CPU 51xS must be located at slot 0 of the VIPA SPEED-Bus slave
with address 100.

The object properties are opened via a double-click on the SPEED-Bus
slave CPU 51xS.

With the parameter Function RS485 the following adjustment
possibilities are given.
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Function RS485

Synchronization
between master
system and CPU

Per default the RS485 interface is used for the Profibus DP master.

Using this parameter the RS485 interface may be switched to PtP
communication (point to point) respectively the synchronization between
DP master system and CPU may be set:

Deactivated Deactivates the RS485 interface

PtP With this operating mode the Profibus DP master
is deactivated and the RS485 interface acts as an
interface for serial point-to-point communication.

Here data may be exchanged between two
stations by means of protocols.

More about this may be found at chapter
"Deployment PtP communication" in this manual.

Profibus-DP async Profibus DP master operation asynchronous to
CPU cycle

The RS485 interface is preset at default to
Profibus-DP async. Here CPU cycle and cycles of
every VIPA Profibus DP master run inde-
pendently.

Profibus-DP syncin The CPU is waiting for DP master input data.

Profibus-DP syncOut The DP master system is waiting for CPU output
data.

Profibus-DP syncinOut CPU and DP master system are waiting on each
other and form thereby a cycle.

Default: Profibus-DP async

Normally the cycle of CPU and DP master run independently. The cycle
time of the CPU is the time needed for one OB1 cycle and for reading
respectively writing the inputs respectively outputs. The cycle time of a DP
Master depends among others on the number of connected slaves and the
baud rate, thus every plugged DP master has its own cycle time.

Due to the asynchronism of CPU and DP master the whole system gets
relatively high response times.
The synchronization behavior between every SPEED-Bus Profibus DP
master and the SPEED7 CPU can be configured by means of a hardware
configuration as shown above.

The different modes for the synchronization are in the following described.
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Profibus-DP
SyncinOut

Profibus-DP
SyncOut

DP master system:

In Profibus-DP SyncIinOut mode CPU and DP master system are waiting
on each other and form thereby a cycle. Here the whole cycle is the sum of
the longest DP master cycle and CPU cycle.

By this synchronization mode you receive global consistent in-/ output data,
since within the total cycle the same input and output data are handled
successively by CPU and DP master system.

If necessary the time of the Watchdog of the bus parameters should be
increased at this mode.
RUN

SPEED7 CPU: ‘ ‘ Cycle ‘ ‘ ‘

SPEED-Bus
Cycle

|
\—’_1

whole cycle

‘ ‘ ‘ ‘ Cycle

In this operating mode the cycle time of the SPEED-Bus DP master system
depends on the CPU cycle time. After CPU start-up the DP master gets
synchronized.

As soon as their cycle is passed they wait for the next synchronization
impulse with output data of the CPU. So the response time of your system
can be improved because output data were directly transmitted to the DP
master system. If necessary the time of the Watchdog of the bus para-
meters should be increased at this mode.

RUN

Cycle CPU > DPM
"1-tier CPU cycle" SPEED-Bus ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘

SPEED7 CPU: ‘ Cycle ‘ ‘ ‘ ‘

DP master system:

Cycle CPU < DPM
"n-tier CPU cycle" SPEED-Bus ‘ ‘ ‘

SPEED7 CPU: ‘ Cycle

DP master system:

Profibus-DP
Syncin

In the operating mode Profibus-DP Syncin the CPU cycle is synchronized
to the cycle of the SPEED-Bus Profibus DP master system.

Here the CPU cycle depends on the speed bus DP master with the longest
cycle time. If the CPU gets into RUN it is synchronized with all speed bus
DP master. As soon as the CPU cycle is passed it waits for the next
synchronization impulse with input data of the DP master system.

If necessary the Scan Cycle Monitoring Time of the CPU should be in-
creased.

RUN
SPEED7 CPU: ‘ Cycle ‘ ‘ ‘ ‘
Cycle CPU > DPM
"n-tier longest DP master cycle" SPEED-Bus ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘
Cycle
DP master system:
RUN
SPEED7 CPU: ‘ ‘ Cycle ‘ ‘ ‘
Cycle CPU < DPM
"1-tier longest DP master cycle" SPEED-Bus

DP master system: ‘ Cycle ‘ ‘ ‘ ‘ ‘ ‘
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Token Watch

Number
remanence flag

Phase offset and
execution of OB33
and OB34

Priority of OB28,
OB29, OB33 and
OB34

This is a VIPA internal parameter. Nothing should be changed here.
Default: On

Here the number of flag bytes may be set. With 0 the value Retentive
memory > Number of memory bytes starting with MBO set at the
parameters of the Siemens CPU 318-2 is used. Otherwise the adjusted
value (1 ... 16384) is used.

Default: 0

The CPU offers additional cyclic interrupts, which interrupt the cyclic
processing in certain distances. Point of start of the time interval is the
change of operating mode from STOP to RUN.

To avoid that the cyclic interrupts of different cyclic interrupt OBs receive a
start request at the same time and so a time out may occur, there is the
possibility to set a phase offset respectively a time of execution.

The phase offset (0 ... 60000ms) serves for distribution processing times
for cyclic interrupts across the cycle.

The time intervals, in which the cyclic interrupt OB should be processed
may be entered with execution (1 ... 60000ms).

Default: Phase offset: 0
Execution: OB33: 500ms
OB34: 200ms

The priority fixes the order of interrupts of the corresponding interrupt OB.
Here the following priorities are supported:

0 (Interrupt-OB is deactivated), 2,3,4,9,12,16,17,24

Default: 24
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Project transfer

Overview

Internal project
transfer via PCI slot
by an Ethernet
connection

The following options are available to transfer a project into the CPU 51x
slot card:

 internal via PCI slot (Ethernet connection)

» external via PC network card (routing necessary)
» external via RS485

» external via Profibus (not for first project)

» external via MMC storage card

a
4
E
E
H
H

PCI Slot

For this transfer method CPU 51xS slot card and Siemens SIMATIC
manager are installed at the same PC.

As soon as the Ethernet and CPU component have been assigned to valid
IP address parameters the CPU 51xS may internal be accessed with the IP
address of its CPU component. Adjust here as PG/PC interface "Intel(R)
8255xER".

For the communication functions of the CPU component a hardware
configuration in which beside the CPU 318-DP a CP 343-1 is configured.
Set the desired IP address parameters here. Please note that the IP
address may differ exclusively in the host ID from the IP address of the
Ethernet component.

Within the PLC function the IP address parameters of the CP 343 may be
used as target parameters.

If the target station indicated by the IP address parameters is not found
during transmission, the original IP parameters for the CPU component
may be entered in a hint dialog.

With confirmation of your input your project will be transferred to the
original IP address. After the restart of the CPU the new IP parameters of
the project are active.
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External project
transfer via PC
network card

For this transfer method it is presupposed that CPU 51xS slot card and a
network card are in the target PC and the network card is connected with
the projecting PC by Ethernet.

So that the CPU 51xS slot card may be accessed by the projecting PC via
the network card a "routing" is necessary. For this details may be found at
"External access to PG/OP channel via routing" above.

Proceed now as described at internal project transfer. Configure a CPU
318-2DP and a CP 343-1. Set the desired IP address parameters here.
Choose at "parameters" "use router" and enter as "Gateway" the IP
address of the Ethernet component of the CPU 51xS slot card.

Within the PLC function the IP address parameters of the CP 343 may be
used as target parameters.

If the target station indicated by the IP address parameters is not found
during transmission, the original IP parameters for the CPU component
may be entered in a hint dialog.

With confirmation of your input your project will be transferred to the
original IP address. After the restart of the CPU the new IP parameters of
the project are active.
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Transfer via RS485

MPI programming
cable

Net structure

Terminating resistor

STEP7
from Siemens
= =]
(—

| Il

For transfer via RS485 there are the following 2 interfaces:
* MPI interface supports maximally 32 PG/OP channels

» PB-DP/PtP interface supports maximally 31 PG/OP channels
(exclusive at Profibus DP master operation)

The MPI programming cables are available at VIPA in different variants.
The deployment of the cables is identical. The cables provide a bus
enabled RS485 plug for the CPU and a RS232 res. USB plug for the PC.

Due to the RS485 connection you may plug the MPI programming cables
directly to an already plugged plug on the RS485 jack. Every bus
participant identifies itself at the bus with an unique address, in the course
of the address 0 is reserved for programming devices.

The structure of a MPI net is in the principal identical with the structure of a
1.5Mbit/s Profibus net. This means the same rules are valid and you use
the same components for the build-up. The single participants are
connected with each other via bus interface plugs and Profibus cables. Per
default the MPI net runs with 187.5kbit/s. VIPA CPUs are delivered with
MPI address 2.

A cable has to be terminated with its surge impedance. For this you switch
on the terminating resistor at the first and the last participant of a network
or a segment.

Please make sure that the participants with the activated terminating
resistors are always provided with voltage during start-up and operation.

MPI Programming cable

Terminating resistor MPI Net Terminating resistor
e e
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Approach transfer
via MPI interface

Approach transfer
via Profibus
interface

Connect your PC to the MPI jack of your CPU via a MPI programming
cable.

Load your project in the SIMATIC manager from Siemens.
Choose in the menu Options > Set PG/PC interface

Select in the according list the "PC Adapter (MPI)"; if appropriate you
have to add it first, then click on [Properties].

Set in the register MPI the transfer parameters of your MPI net and type
a valid address.

Switch to the register Local connection

Set the COM port of the PC and the transfer rate 38400bit/s for the MPI
programming cable from VIPA.

Via PLC > Load to module you may transfer your project via MPI to the
CPU and save it on a MMC via PLC > Copy RAM to ROM if one is
plugged.

Connect your PC to the DP-PB/PtP jack of your CPU via a MPI
programming cable.

Load your project in the Siemens SIMATIC manager.
Choose in the menu Options > Set PG/PC interface

Select in the according list the "PC Adapter (Profibus)"; if appropriate
you have to add it first, then click on [Properties].

Set in the register Profibus the transfer parameters of your Profibus net
and type a valid Profibus address. The Profibus address must be
assigned to the DP master by a project before.

Switch to the register Local connection

Set the COM port of the PCs and the transfer rate 38400bit/s for the
MPI programming cable from VIPA.

Via PLC > Load to module you may transfer your project via Profibus to
the CPU and save it on a MMC via PLC > Copy RAM to ROM if one is

plugged.

Note!

An according project with an activated Profibus must have been loaded to
the CPU before (not suited for first start-up), otherwise the CPU may not be
reached after a overall reset.
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Transfer via
MMC

Reserved file
names

Transfer
MMC - CPU

Transfer
CPU - MMC

Transfer control

The MMC (Memory Card) serves as external transfer and storage medium
for programs and firmware. It has the PC compatible FAT16 file system.

There may be stored several projects and sub-directories on a MMC
storage module. Please regard that your current project respectively the file
with the reserved file name is stored in the root directory.

With an overall reset, PowerON or CPU-STOP the MMC is automatically
read. By presetting a reserved file name the functionality of the CPU may
be influenced.

File name Description

S7PROG.WLD Project file - is read after overall reset respectively may
be written by CPU by an order.

AUTOLOAD.WLD | Project file - is read after PowerON.

PROTECT.WLD | Protected project file
(see "Extended know-how protection").

VIPA_ CMD.MMC |Command file - file is once executed during CPU-
STOP by plugging a MMC or after PowerON
(see "MMC-Cmd - Auto command").

*.pkg Firmware file - is recognized after PowerON and may
be installed by means of an update request
(see "Firmware update").

The transfer of the application program from the MMC into the CPU takes
place depending on the file name after overall reset or PowerON. The
blinking of the LED "MCC" of the CPU marks the active transfer.

A transfer from CPU to MMC only happens if the size of the user memory
exceeds the size of the user program. Else a memory expansion via MCC
iS necessary.

When the MMC has been installed, the write command stores the content
of the battery buffered RAM as S7TPROG.WLD at the MMC. The write
command is controlled by means of the Siemens hardware configurator via
PLC > Copy RAM to ROM. During the write process the "MMC"-LED of the
CPU is blinking. When the LED expires the write process is finished.

After a write process on the MMC, an according ID event is written into the
diagnostic buffer of the CPU. To monitor the diagnosis entries, you select
PLC > Module Information in the Siemens SIMATIC manager. Via the
register "Diagnostic Buffer" you reach the diagnosis window.

When writing on the MMC, the following events may occur:

Event-ID Meaning

O0xE100 MMC access error

OxE101 MMC error file system

OxE102 MMC error FAT

0xE200 MMC writing finished successful
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Operating modes

Overview

Operating mode
STOP

Operating mode
START-UP

Operating mode
RUN

The CPU has 4 operating modes:

operating mode STOP
operating mode START-UP
operating mode RUN
operating mode FLAG

Certain conditions in the operating modes START-UP and RUN require a
specific reaction from the system program. In this case the application
interface is often provided by a call to an organization block that was
included specifically for this event.

Processing of the application program has stopped.

If the program was being processed before, the values of counters,
timers, flags and the contents of the process image are retained during
the transition to the STOP mode.

Outputs are inhibited, i.e. all digital outputs are disabled.
RN-LED off
ST-LED on

During the transition from STOP to RUN a call is issued to the start-up
organization block OB 100. The length of this OB is not limited. The
processing time for this OB is not monitored. The start-up OB may issue
calls to other blocks.

All digital outputs are disabled during the start-up, i.e. outputs are
inhibited.

RN-LED blinks

ST-LED off

When the CPU has completed the start-up OB, it assumes the operating
mode RUN.

The application program in OB 1 is processed in a cycle. At the control
of alarms other program sections can be included in the cycle.

All timers and counters, being started by the program, are active and the
process image is updated with every cycle.

The BASP-signal (outputs inhibited) is deactivated, i.e. all digital outputs
are enabled.

RN-LED on
ST-LED off
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Operating mode
FLAG

Preconditions

Approach with
break points

Behavior in
operating mode
FLAG

The CPU 51xS provides the opportunity to define up to 4 break points
(flags) for program diagnosis purposes. The flags are set and deleted via
your programming neighborhood. As soon as a break point is reached, you
may execute your application line by line and may activate in- and outputs.

For the usage of break points, the following preconditions must be fulfilled:

» The single step test mode is only available for STL, if needed, change
the view via View > STL to STL.

» The block has to be opened online and must not be protected.
» The opened block must not have been altered in the editor.

» Activate the break point bar via View > Break point bar.
» Put the cursor to the statement line where a break point is to be set.

» Set the break point with Test > Set break point. The statement line is
marked with a ring.

» To activate the break point, choose Test > Break point active. The ring
changes to a circle.

» Switch the CPU to RUN. When the user application reaches the break
point, the CPU switches into the state FLAG, the break point is marked
with an arrow and the register contents are shown.

 Now you may execute your application code step by step via Test >
Next command or execute the application until the next break point with
Test > Continue.

* Test > Delete (all) break points deletes (all) break points.

» LED RN blinks and LED ST is on.

» The code execution has been stopped. All run levels are not executed.
» All timer are frozen.

» The real-time clock is still active.

» The outputs are shut down, but may be released for test purposes.

» Passive CP communication is possible.

Note!

The usage of break points is possible at any time. A switch to the operating
mode “Test operation” is not required.

If you set more than 3 break points, the single step operation is not longer
available.

3-40

HB145E - CPU - RE_517-2AJ02 - Rev. 10/23



Manual VIPA System 500S SPEED7

Chapter 3 Deployment CPU 517S/DPM

Function The CPUs include security mechanisms like a Watchdog (100ms) and a
security parameterizable cycle time surveillance (parameterizable min. 1ms) that
stop res. execute a RESET at the CPU in case of an error and set it into a
defined STOP state.
The VIPA CPUs are developed function secure and have the following
system properties:
Event concerns Effect
RUN - STOP |general BASP (Befehls-Ausgabe-Sperre, i.e. command
output lock) is set.
central digital outputs The outputs are set to OV.
central analog outputs The voltage supply for the output channels is
switched off.
decentral outputs The outputs are set to OV.
decentral inputs The inputs are read constantly from the slave and
the recent values are put at disposal.
STOP - RUN |general First the PIl is deleted, then OB 100 is called. After

res. Power on

central analog outputs

decentral inputs

the execution of the OB, the BASP is reset and
the cycle starts with:

Delete PIQ - Read PIl - OB1.

The behavior of the outputs at restart can be
preset.

The inputs are read constantly from the slave and
the recent values are put at disposal.

RUN

general

The program execution happens cyclically and can
therefore be foreseen:
Read PIl . OB1 - Write PlQ.

Pll: = Process image inputs
PIQ: = Process image outputs
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Overall reset

Overview

Overall reset by
means of the
operating mode
switch

During the overall reset the entire user memory (RAM) and the retentive
memory area is erased.

Data located on the storage medium (MMC, MCC) is not affected.

You should always issue an overall reset to your CPU before loading an
application program into your CPU, to ensure that all blocks have been
cleared from it.

Condition

The operating mode of the CPU is STOP. Place the operating mode switch
on the CPU in position "STOP" — The ST-LED is on.

Overall reset

* Place the operating mode switch in the position MR and hold it in this
position for app. 3 seconds. — The ST-LED changes from blinking to
permanently on.

» Place the operating mode switch in the position STOP and switch it to
MR and quickly back to STOP within a period of less than 3 seconds.

— The ST-LED blinks (overall reset procedure).

» The overall reset has been completed when the ST-LED is on
permanently. -~ The ST-LED is on.

The following figure illustrates the above procedure:

@ @ ©) @

AN /7 AN /7
oMl O w ol O W
RN ST RN ST RN ST RN ST
RN RN RN RN
BSeC'l @ST ST l — ST ST
MR MR MR MR

| 3 Sec. |
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Overall reset via
PLC-Tool

Overall reset via
SIMATIC manager
from Siemens

Automatic reload

At deployment of the operating software PLC-Tool you may initialize the
Overall reset via the button [M-RES].

The button is available as soon as your CPU is in STOP.

x

File ©CPU Options 7

FLC FPE-h4
B PR W EUM
M EUN M ERR

STOF BCE
B IF
B HMMC ,

B FRCE

RLIM
5TOP
M-RES

Conditions

Your CPU has to be in STOP.
Via the menu command PLC > Operating Mode you switch your CPU in
STOP.

Overall reset

Via the menu command PLC > Clear/Reset you request the overall reset.
In the dialog window you may switch your CPU to STOP if you didn't that
yet and start the overall reset.

During the overall reset procedure the ST-LED is blinking.

When the ST-LED changes to permanently on, the overall reset has been
finished.

After the overall reset the CPU attempts to reload the parameters and the
program from the memory card. -~ The MMC-LED at the board blinks.
When the reload has been completed, the LED extinguishes. The
operating mode of the CPU will be STOP or RUN, depending on the
position of the operating mode switch.
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Firmware update

Overview

Latest Firmware at
www.vipa.de

The CPU offer you the opportunity to execute a firmware update for the
CPU via MMC.

For this an accordingly prepared MMC must be in the CPU during the start-
up.

So a firmware files can be recognized and assigned with start-up, a pkg file
name is reserved for each updateable component an hardware release,
which begins with "px" and differs in a number with six digits.

As soon as with start-up a pkg file is on the MMC and the firmware is more
current than in the components, all the pkg file assigned components within
the CPU get the new firmware.

The latest 2 firmware versions may be found in the service area at
www.vipa.de.

For example the following files are necessary for the firmware update of
the CPU 517-2AJ02 and its components (Profibus) with hardware release
1:

* 517-2AJ02, Hardware release 1: Px000117.zip
» Profibus DP master (integrated): Px000119.zip
Attention!

When installing a new firmware you have to be extremely careful. Under
certain circumstances you may destroy the CPU, for example if the voltage
supply is interrupted during transfer or if the firmware file is defective.

In this case, please call the VIPA-Hotline!

Please regard that the version of the update firmware has to be different
from the existing firmware otherwise no update is executed.
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Display firmware Every SPEED7-CPU has got an integrated web page that monitors

version of the information about firmware version of the SPEED7 components. The

SPEED7 system Ethernet-PG/OP channel provides the access to this web page.

via Web page More detailed information can be found at "Access to integrated web
page".

Load firmware and ¢ Go to www.vipa.de.
transfer it tg_ + Navigate to "Firmware".
storage media « Click at "System 500S".

» Choose the according modules and download the firmware Px......zip to
your PC.
» Extract the zip-file and copy the extracted file to your MMC.

» Following this approach, transfer all wanted firmware files to your MMC.

Attention!

With a firmware update an overall reset is automatically executed. If your
program is only available in the load memory of the CPU it is deleted! Save
your program before executing a firmware update! After the firmware
update you should execute a "Set back to factory settings" (see following

page).
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Transfer firmware 1.

from MMC to CPU

MMC, FRCE, SF, PWR

RN, ST et

)

Preparation

2)

Firmware
recognized
at MMC

o O

RN ST

l RN
MR

SPEED
l LINK

COLL

Get the RUN-STOP lever of your CPU in position STOP. Turn off the
voltage supply. In installed condition depending upon operating
system now you get a message that the connected partner is no
longer present. This message can be ignored. Plug the MMC with the
firmware files into the CPU. Please take care of the correct plug-in
direction of the MMC. Turn on the voltage supply.

. After a short boot-up time, the alternate blinking of the LEDs SF and

FRCE shows that at least a more current firmware file was found on
the MMC.

You start the transfer of the firmware as soon as you tip the
RUN/STOP lever downwards to MRES within 10s.

During the update process, the LEDs SF and FRCE are alternately
blinking and MMC LED is on. This may last several minutes.

The update is successful finished when the LEDs PWR, STOP, SF,
FRCE and MCC are on. If they are blinking fast, an error occurred.

Turn Power OFF and ON. Now it is checked by the CPU, whether
further current firmware versions are available at the MMC. If so,
again the LEDs SF and FRCE flash after a short start-up period.
Continue with point 3.

If the LEDs do not flash, the firmware update is ready.

Now a factory reset should be executed (see next page). After that
the CPU is ready for duty.

)

Start update

@)

Update runs

s

Update
terminates
error free

O

Error

O @ O:>%¢
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7
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COLL
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Insert MMC
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MMC
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Factory reset

Proceeding

W @

CPU in
STOP

o O

RN

ST

With the following proceeding the internal RAM of the CPU is completely
deleted and the CPU is reset to delivery state.

Please note that here also the MPI address is reset to the default address
2 and the IP address of the Ethernet PG/OP channel is reset to 0.0.0.0!

A factory reset may also be executed by the MMC-Cmd FACTORY _
RESET. More information may be found at "MMC-Cmd - Auto commands".

Switch the CPU to STOP.

Push the operating switch down to position MR for 30s. Here the ST-
LED flashes. After a few seconds the ST-LED changes to static light.
Now the ST-LED changes between static light and flashing. Starting
here count the static light states.

After the 6. static light release the operating mode switch and tip it
shortly downwards to MR.

For the confirmation of the resetting procedure the green run LED gets
ON within 0.5s. If not the factory reset has failed and only an overall
reset was executed. In this case you can repeat the procedure. An
factory reset can only be executed if the stop LED has static light for
exactly 6 times.

The end of factory reset is showing by static light of the LEDs STOP,
SF, FRCE and MMC. Switch the power supply off and on.

The proceeding is shown in the following lllustration:

Request factory reset

30 Sec.

® © g

Start factory reset Factory reset Error: Only
executed overall reset
executed
s
PO SN O O ®@ © O O o o0 O ¢
ST 6X RN ST RN ST RN ST RN ST RN ST

RN Tip RN
R
MR MR

| | 1 Sec. | | 0,5 Sec. 0,5 Sec.

Note!
After the firmware update you always should execute a Factory reset.

HB145E - CPU - RE_517-2AJ02 - Rev. 10/23 3-47



Chapter 3 Deployment CPU 517S/DPM Manual VIPA System 500S SPEED7

Memory expansion with MCC

Overview

ViPA 953-1L.Poo

Approach

Behavior

You have the option to expand the work memory of your CPU.

For this, a MCC (Memory Configuration Card) is available at VIPA. The
MCC is a specially prepared MMC (Multimedia Card). By plugging the MCC
into the MCC slot and then an overall reset the according memory
expansion is released. There may only one memory expansion be
activated at the time.

On the MCC there is the file memory.key. This file may not be altered or
deleted. You may use the MCC also as "normal" MMC for storing your
project.

To extend the memory, plug the MCC into the card slot at the CPU labeled
with "MCC" and execute an overall reset.

Overall reset
N 7 AN
O =< O ¥ O¥
ST RN ST RN ST

RN

R

— Memory is extended for the MCC memory configuration
(diagnostic entry 0xE400).

If the memory expansion on the MCC exceeds the maximum extendable

memory range of the CPU, the maximum possible memory of the CPU is
automatically used.

You may determine the recent memory extension via the Siemens
SIMATIC manager at Module Information - "Memory".

7
AN

Attention!

Please regard that the MCC must remain plugged when you've executed
the memory expansion at the CPU. Otherwise the CPU switches to STOP
after 72h. The MCC can not be exchanged with a MCC of the same
memory configuration.

When the MCC memory configuration has been set you may find the
diagnosis entry 0xE400 in the diagnostic buffer of the CPU.

After pulling the MCC the entry 0xE401 appears in the diagnostic buffer,
the SF-LED is on and after 72h the CPU switches to STOP. A reboot is
only possible after plugging-in the MCC again or after an overall reset.
After re-plugging the MCC, the SF-LED extinguishes and OxE400 is
entered into the diagnostic buffer. You may reset the memory configuration
of your CPU to the initial status at any time by executing an overall reset
without MCC.
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Extended know-how protection

Overview

Standard protection

Extended protection

PC

Besides the "standard" know-how protection the SPEED7-CPUs from VIPA
provide an "extended" know-how protection that serves a secure block
protection for accesses of third persons.

The standard protection from Siemens transfers also protected blocks to
the PG but their content is not displayed. But with according manipulation
the know-how protection is not guaranteed.

The "extended" know-how protection developed by VIPA offers the
opportunity to store blocks permanently in the CPU.

At the "extended" protection you transfer the protected blocks into a wid file
named protect.wld. By plugging the MMC and following overall reset, the
blocks in the protect.wld are permanently stored in the CPU.

You may protect OBs, FBs and FCs.

When back-reading the protected blocks into the PG, exclusively the block
header are loaded. The source remains in the CPU and is thus protected
for accesses of third persons.

Blocks

b
e

MMC

protect.wld
>

Overall reset
" O >3s O ¥ O ®:
RN ST RN ST RN ST
’M Tip
W@ @l

—

[

)

Jats

B 4/@@/ Protected blocks are located in the CPU
W/
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protect blocks
with protect.wld

Transfer
protect.wld to CPU
with overall reset

Protection
behavior

Change respectively
delete protected
blocks

Usage of
protected blocks

Create a new wid file in your project engineering tool with File > Memory
Card file > New and rename it to "protect.wld".

Transfer the according blocks into the file by dragging them with the mouse
from the project to the file window of protect.wld.

Transfer the file protect.wld to a MMC storage module, plug the MMC into
the CPU and execute an overall reset with the following approach:

@ @ ©) @

O=¥¥: O ¥,  O-¥EE O ¥
RN ST RN ST RN ST RN ST
RN RN RN RN
MR MR MR MR

| 3 Sec. |

The overall reset stores the blocks in protect.wld permanently in the CPU
protected from accesses of third persons.

Protected blocks are overwritten by a new protect.wid.

Using a PG third persons may access protected blocks but only the block
header is transferred to the PG. The block code that is to protect remains
in the CPU and can not be read.

Protected blocks in the RAM of the CPU may be substituted at any time by
blocks with the same name. This change remains up to next overall reset.
Protected blocks may permanently be overwritten only if these are deleted
at the protect.wld before.

By transferring an empty protect.wld from the MMC you may delete all
protected blocks in the CPU.

Due to the fact that reading of a "protected" block from the CPU monitors
no symbol labels it is convenient to provide the "block covers" for the end
user.

For this, create a project out of all protected blocks. Delete all networks in
the blocks so that these only contain the variable definitions in the
according symbolism.
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MMC-Cmd - Auto commands

Overview A command file at a MMC may be started automatically when the MMC is
stuck and the CPU is in STOP. As soon as the MMC is stuck the command
file is once executed at CPU STOP up to the next PowerON.

The command file is a text file, which consists of a command sequence to
be stored as vipa_cmd.mmc in the root directory of the MMC.

The file has to be started by CMD_START as 1. command, followed by the
desired commands (no other text) und must be finished by CMD_END as
last command.

Text after the last command CMD_END e.g. comments is permissible,
because this is ignored. As soon as the command file is recognized and
executed each action is stored at the MMC in the log file logfile.txt. In
addition for each executed command a diagnostics entry may be found in
the diagnostics buffer.

Commands In the following there is an overview of the commands. Please regard the
command sequence is to be started with CMD_START and ended with
CMD_END.

Command Description Diagnostics entry

CMD_START In the first line CMD_START is to be located. 0xE801
There is a diagnostic entry if CMD_START is missing OxE8FE

WAIT1SECOND Waits ca. 1 second. 0xE803

WEBPAGE The current web page of the CPU is stored at the MMC 0xE804
as "webpage.htm".

LOAD PROJECT The function "Overall reset and reload from MMC" is 0xE805
executed. The wld file located after the command is
loaded else "s7prog.wld" is loaded.

SAVE_PROJECT The recent project (blocks and hardware configuration) 0xE806

[password] is stored as "s7prog.wld" at the MMC.

If the file just exists it is renamed to "s7prog.old".

If your project is password protected you have to add to
SAVE_PROJECT your password as parameter.
Example: Password = "vipa": SAVE_PROJECT vipa

FACTORY RESET |Executes "factory reset". 0xE807

DIAGBUF The current diagnostics buffer of the CPU is stored as OxE80B
"diagbuff.txt" at the MMC.

SET _NETWORK IP parameters for Ethernet PG/OP channel may be set OxE8OE
by means of this command.

The IP parameters are to be given in the order IP
address, subnet mask and gateway in the format
XXX.XXX.XXX.XXX each separated by a comma.
Enter the IP address if there is no gateway used.
CMD_END In the last line CMD_END is to be located. 0xE802
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Examples

The structure of a command file is shown in the following. The

corresponding diagnostics entry is put in parenthesizes.

Example 1

CMD_START

LOAD PRQIECT proj.w d
WAl TLSECOND

WEBPAGE

DI AGBUF

CVMD_END

arbitrary text

Example 2

CMD_START
LOAD_PRQJECT proj 2. W d
WAl T1SECOND
WAl T1SECOND

SET_NETWORK 172. 16. 129. 210, 255. 255. 224. 0, 172. 16. 129. 210

WAl T1SECOND
WAl T1SECOND
W\EBPAGE
DI AGBUF
CMD_END

arbitrary text

Note!

Marks the start of the command sequence (0xE801)

Execute an overall reset and load "proj.wld" (OXE805)

Wait ca. 1s (OxE803)

Store web page as "webpage.htm" (0xE804)

Store diagnostics buffer of the CPU as "diagbuff.txt" (OXE80B)
Marks the end of the command sequence (0xE802)

Text after the command CMD_END is not evaluated.

Marks the start of the command sequence (0xE801)

Execute an overall reset and load "proj2.wld" (OXE805)

Wait ca. 1s (OxE803)

Wait ca. 1s (OxE803)

IP parameter
(OXE8OE)
Wait ca. 1s (OxE803)

Wait ca. 1s (OxE803)

Store web page as "webpage.htm" (0xE804)

Store diagnostics buffer of the CPU as "diagbuff.txt" (OXE80B)
Marks the end of the command sequence (0xE802)

Text after the command CMD_END is not evaluated.

The parameters IP address, subnet mask and gateway may be received
from the system administrator.

Enter the IP address if there is no gateway used.
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VIPA specific diagnostic entries

Entries in the You may read the diagnostic buffer of the CPU via the Siemens SIMATIC
diagnostic buffer manager. Besides of the standard entries in the diagnostic buffer, the VIPA
CPUs support some additional specific entries in form of event-IDs.

The current content of the diagnostics buffer is stored on MMC by means

of the MMC-Cmd DIAGBUF. More information may be found at "MMC-Cmd
- Auto commands".

Note!

Every register of the module information is supported by the VIPA CPUs.
More information may be found at the online help of the Siemens SIMATIC
manager.

Monitoring the To monitor the diagnostic entries you choose the option PLC > Module
diagnostic entries Information in the Siemens SIMATIC manager. Via the register "Diagnostic
Buffer" you reach the diagnostic window:

FB Module Information - cPU318-z I EIEE
PBath: |.~'-‘u:c:essi|:ule MHodes'MPl = 2 [directiy) Operating mode of the CPLU: @ RM
Status: Mot a force job
Time System | Performance Data I Communication I Stacks
General Diagnostic Buffer | kd ernory I Scan Cecle Time
Ewents: [~ | Eilter, settings active ™| Time including CRUocal time difference
[ [a | Tirne of day | Date | Ewent |i|

10 07:44: 22020 prn 03/28/068  Request for automatic warm restart

11 01:44:22:020 pm 03/28/068  Made transition from STOP o STARTUP

12 01:43:57:434 pm 03/28/06  STOP cauzed by PG stop operation or by SFB 20 "STO. .
13 01:43:51:356 pm 03/28/06 Ewent|D: 168 EQCC

14 01:42:26:687 pm 03/28/068  Mode tranzition from STAF

15 01:42:26:686 pm 03/28/068  Request for automatic warm .wu..v PA | D
16 01:42:26:686 pm 03/28/068  Mode transition from STEI o STARTL

17 01:42:16:904 pm 03/28/06 Ewent|D: 168 EQCC

Detailz on Ewent: 1of18 Event|D: 168 4302

t ode trangition from STARTUP to RUMN o=
Startup information:

- Difference between etpoint and actual configuration

- Time for time stamp at the last backed up power on

- Single processzor operation

Current/lazt startup twoe: LI

Save As... | Settings... | [Hper Block Help an Event |
Cloze | Update | Frint._. | Help |

The diagnosis is independent from the operating mode of the CPU. You
may store a max. of 100 diagnostic entries in the CPU.

The following page shows an overview of the VIPA specific Event-IDs.
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Overview of the
Event-IDs

Event-ID | Description

OxE003 Error at access to I/O devices
Zinfo1: 1/O address
Zinfo2: Slot

OxE004 | Multiple parameterization of a I/O address
Zinfo1: 1/0 address
Zinfo2: Slot

OxE005 Internal error - Please contact the VIPA-Hotline!

OxEO06 Internal error - Please contact the VIPA-Hotline!

0xEOQ07 | Configured in-/output bytes do not fit into I/O area

OxEO008 Internal error - Please contact the VIPA-Hotline!

OxEO009 | Error at access to standard back plane bus

O0xEO010 | Not defined module group at backplane bus recognized
Zinfo2: Slot
Zinfo3: Type ID

0xEO011 Master project engineering at Slave-CPU not possible or wrong slave configuration

O0xEO012 | Error at parameterization

0xEO013 | Error at shift register access to standard bus digital modules

OxEO014 | Error at Check_Sys

OxEO015 Error at access to the master
Zinfo2: Slot of the master (32=page frame master)

OxEO016 Maximum block size at master transfer exceeded
Zinfo1: 1/O address
Zinfo2: Slot

OxEOQ17 | Error at access to integrated slave

0xE018 | Error at mapping of the master I/O devices

OxEO19 | Error at standard back plane bus system recognition

OxEO1A | Error at recognition of the operating mode (8 / 9bit)

OxEO1B | Error - maximum number of plug-in modules exceeded

OxE030 Error of the standard bus

OxEOBO | SPEED?Y is not stoppable (probably undefined BCD value at timer)

OxEOCO | Not enough space in work memory for storing code block (block size exceeded)

OxEOCC | Communication error MPI / Serial

OXEOCD | Error at DPV1 job management

OxEOCE | Error: Timeout at sending of the i-slave diagnostics

OxE100 MMC access error

O0xE101 | MMC error file system

OxE102 MMC error FAT

OxE104 | MMC error at saving

0xE200 | MMC writing finished (Copy Ram2Rom)

continued ...
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... continue
Event-ID | Description
0xE210 | MMC reading finished (reload after overall reset)
OxE21F | MMC reading: error at reload (after overall reset), read error, out of memory
OxE400 | Memory expansion MCC has been plugged
0xE401 Memory expansion MCC has been removed
0xE801 MMC-Cmd: CMD_START recognized and successfully executed
0xE802 | MMC-Cmd: CMD_END recognized and successfully executed
0xE803 | MMC-Cmd: WAIT1SECOND recognized and successfully executed
O0xE804 | MMC-Cmd: WEBPAGE recognized and successfully executed
0xE805 | MMC-Cmd: LOAD_ PROJECT recognized and successfully executed
OxE806 | MMC-Cmd: SAVE_ PROJECT recognized and successfully executed
0xE807 | MMC-Cmd: FACTORY_RESET recognized and successfully executed
OxE80B | MMC-Cmd: DIAGBUF recognized and successfully executed
OxE8O0E |MMC-Cmd: SET_NETWORK recognized and successfully executed
OXxE8FB | MMC-Cmd: Error: Initialization of the Ethernet PG/OP channel by means of
SET_NETWORK is faulty.
OXxE8FC | MMC-Cmd: Error: Not every IP-Parameter is set at SET_NETWORK.
OxE8FE | MMC-Cmd: Error: CMD_START was not found
OxE8FF | MMC-Cmd: Error: Reading the CMD file is faulty (MMC error)
0xE901 Check sum error
OXEAOO0 |Internal error - Please contact the VIPA-Hotline!
OxEAO01 Internal error - Please contact the VIPA-Hotline!
OxEAO02 |SBUS: Internal error (internal plugged sub module not recognized)
Zinfo1: Internal slot
OxEAO04 | SBUS: Multiple parameterization of a I/O address
Zinfo1: 1/0O address
Zinfo2: Slot
Zinfo3: Data width
OXEAO5 |Internal error - Please contact the VIPA-Hotline!
OxEAQ7 |Internal error - Please contact the VIPA-Hotline!
OxEAO08 | SBUS: Parameterized input data width unequal to plugged input data width
Zinfo1: Parameterized input data width
Zinfo2: Slot
Zinfo3: Input data width of the plugged module
OxEAQ9 |SBUS: Parameterized output data width unequal to plugged output data width

Zinfo1: Parameterized output data width
Zinfo2: Slot
Zinfo3: Output data width of the plugged module

continued ...
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... continue
Event-ID | Description
OxEA10 | SBUS: Input address outside input area
Zinfo1: 1/0 address
Zinfo2: Slot
Zinfo3: Data width
OxEA11 | SBUS: Output address outside output area
Zinfo1: 1/0 address
Zinfo2: Slot
Zinfo3: Data width
OxEA12 | SBUS: Error at writing record set
Zinfo1: Slot
Zinfo2: Record set number
Zinfo3: Record set length
OxEA14 | SBUS: Multiple parameterization of a I/O address (Diagnostic address)
Zinfo1: 1/0 address
Zinfo2: Slot
Zinfo3: Data width
OxEA15 |Internal error - Please contact the VIPA-Hotline!
OxEA18 | SBUS: Error at mapping of the master I/O devices
Zinfo2: Master slot
OxEA19 |Internal error - Please contact the VIPA-Hotline!
OxEA20 |Error - RS485 interface is not set to Profibus DP master but there is a Profibus DP
master configured.
OxEA21 | Error - Project engineering RS485 interface X2/X3:
Profibus DP master is configured but missing
Zinfo2: Interface x
OxEA22 |Error - RS485 interface X2 - value is out of range
Zinfo: Configured value X2
OxEA23 |Error - RS485 interface X3 - value is out of range
Zinfo: Configured value X3
OxEA24 | Error - Project engineering RS485 interface X2/X3:
Interface/Protocol is missing, the default settings are used.
Zinfo2: Configured value X2
Zinfo2: Configured value X3
OxEA30 |Internal error - Please contact the VIPA-Hotline!
OxEA40 |Internal error - Please contact the VIPA-Hotline!
OxEA41 Internal error - Please contact the VIPA-Hotline!
OxEA98 | Timeout at waiting for reboot of a SBUS module (Server)
OxEA99 |Error at file reading via SBUS
OxEEOQOO |Internal error - Please contact the VIPA-Hotline!

3-56

HB145E - CPU - RE_517-2AJ02 - Rev. 10/23

Manual VIPA System 500S SPEED7




Manual VIPA System 500S SPEED?7 Chapter 3 Deployment CPU 517S/DPM

Using test functions for control and monitoring of variables

Overview

Debug > Monitor

For troubleshooting purposes and to display the status of certain variables
you can access certain test functions via the menu item Debug of the
Siemens SIMATIC manager.

The status of the operands and the VKE can be displayed by means of the
test function Debug > Monitor.

You can modify and/or display the status of variables by means of the test
function PLC > Monitor/Modify Variables.

This test function displays the current status and the VKE of the different
operands while the program is being executed.

It is also possible to enter corrections to the program.

Note!
When using the test function “Monitor” the PLC must be in RUN mode!

The processing of the states may be interrupted by means of jump
commands or by timer and process-related alarms. At the breakpoint the
CPU stops collecting data for the status display and instead of the required
data it only provides the PG with data containing the value 0.

For this reason, jumps or time and process alarms can result in the value
displayed during program execution remaining at 0 for the items below:

» the result of the logical operation VKE

» Status / AKKU 1

 AKKU 2

» Condition byte

» absolute memory address SAZ. In this case SAZ is followed by a "?".

The interruption of the processing of statuses does not change the
execution of the program. It only shows that the data displayed is no
longer.
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PLC >
Monitor/Modify
Variables

This test function returns the condition of a selected operand (inputs,
outputs, flags, data word, counters or timers) at the end of program-
execution.

This information is obtained from the process image of the selected
operands. During the "processing check" or in operating mode STOP the
periphery is read directly from the inputs. Otherwise only the process
image of the selected operands is displayed.

Control of outputs
It is possible to check the wiring and proper operation of output-modules.

You can set outputs to any desired status with or without a control
program. The process image is not modified but outputs are no longer
inhibited.

Control of variables
The following variables may be modified:
I,Q M, T, CandD.

The process image of binary and digital operands is modified
independently of the operating mode of the CPU 51xS.

When the operating mode is RUN the program is executed with the
modified process variable. When the program continues they may,
however, be modified again without notification.

Process variables are controlled asynchronously to the execution sequence
of the program.
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Chapter 4 Deployment CPU with Profibus

Overview Content of this chapter is the deployment of the CPU 517S/DPM with
Profibus. After a short overview the project engineering and
parameterization of a CPU 517S/DPM with integrated Profibus-Part from
VIPA is shown.

Further you get information about usage as DP master and DP slave of the
Profibus part.

The chapter is ended with notes to commissioning and start-up.
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Overview

Profibus DP

CPU with
DP master

Deployment of the
DP Master with
CPU

DP slave operation

Profibus is an international standard applicable to an open and serial field
bus for building, manufacturing and process automation that can be used
to create a low (sensor-/actuator level) or medium (process level)
performance network of programmable logic controllers.

Profibus comprises an assortment of compatible versions. The following
details refer to Profibus DP.

Profibus DP is a special protocol intended mainly for automation tasks in a
manufacturing environment. DP is very fast, offers Plug'n'Play facilities and
provides a cost-effective alternative to parallel cabling between PLC and
remote I/O. Profibus-DP was designed for high-speed data communication
on the sensor-actuator level. The data transfer referred to as "Data
Exchange" is cyclical. During one bus cycle, the master reads input values
from the slaves and writes output information to the slave.

The Profibus DP master is to configure via the hardware configurator from
Siemens. Therefore you have to choose the Siemens-CPU 318-2AJ00 in
the hardware configurator from Siemens.

The transmission of your project engineering into the CPU takes place by
means of MPI. This is internally passing on your project data to the
Profibus master part.

During the start-up the DP master automatically includes his data areas
into the address range of the CPU. A project engineering in the CPU is not
required.

As external storage medium the Profibus DP master uses the MMC
(Multi Media Card) together with the CPU.

Via the Profibus DP master up to 124 Profibus DP slaves may be coupled
to the CPU. The DP master communicates with the DP slaves and links up
its data areas with the address area of the CPU. There may be created
maximal 1024Byte Input and 1024Byte Output data.

At every POWER ON res. overall reset the CPU fetches the 1/0 mapping
data from the master.

At DP slave failure, the ER-LED is on and the OB 86 is requested. If this is
not available, the CPU switches to STOP and BASP is set.

As soon as the BASP signal comes from the CPU, the DP master is setting
the outputs of the connected periphery to zero. The DP master remains in
the operating mode RUN independent from the CPU.

For the deployment in an super-ordinated master system you first have to
project your slave system as CPU 318-2DP (6ES7 318-2AJ00-0AB0/V3.0)
in Slave operation with configured in-/output areas. Afterwards you
configure your master system. Assign your slave system to your master
system by dragging the "CPU 31x" from the hardware catalog at
Configured stations onto the master system, choose your slave system and
connect it.

4-2
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Project engineering CPU with integrated Profibus master

Overview

Preconditions

Install Siemens
Hardware
configurator

Configure
DP master

For the project engineering of the Profibus DP master you have to use the
hardware manager from Siemens. Your Profibus projects are transferred
via MPI to the CPU by means of the "PLC" functions. The CPU passes the
data on to the Profibus DP master.

For the project engineering of the Profibus DP master in the
CPU 51xS/DPM the following preconditions have to be fulfilled:

» Siemens SIMATIC Manager has to be installed.

» With Profibus DP slaves of the Systems 100V, 200V and 300V from
VIPA: GSD Files are included into the hardware configurator.

» There is a transfer possibility between configuration tool and CPU 51xS.

Note!

For the project engineering of the CPU and the Profibus DP master a
thorough knowledge of the Siemens SIMATIC manager is required!

The hardware configurator is a part of the Siemens SIMATIC Manager. It
serves the project engineering. The modules that may be configured here,
are listed in the hardware catalog.

For the deployment of the Profibus DP slaves of the Systems 100V, 200V
and 300V from VIPA you have to include the modules into the hardware
catalog by means of the GSD file from VIPA.

» Create a new project System 300.
» Add a profile rail from the hardware catalog.

» In the hardware catalog the CPU with Profibus master is listed as:
Si mat i ¢300/ CPU- 300/ CPU318- 2DP/ 6ES7 318- 2AJ00- 0ABO

* Insert the CPU 318-2DP (6ES7 318-2AJ00-0ABO).
» Type the Profibus address of your master (e.g. 2).

* Click on DP, choose the operating mode "DP master" under object
properties and confirm your entry with OK.

» Click on "DP" with the right mouse button and choose "add master
system".

» Create a new Profibus subnet via NEW.
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Now the project engineering of your Profibus DP master is finished. Please
link up now your DP slaves with periphery to your DP master.

» For the project engineering of Profibus DP slaves you search the
concerning Profibus DP slave in the hardware catalog and drag&drop it
in the subnet of your master.

» Assign a valid Profibus address to the DP slave.

» Link up the modules of your DP slave system in the plugged sequence
and add the addresses that should be used by the modules.

» If needed, parameterize the modules.

You may deploy your Profibus part from the SPEED7-CPU as DP slave.
The approach is described on the following page.
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Deployment as Profibus DP slave

Fast introduction The deployment of the Profibus section as "intelligent" DP slave happens
exclusively at master systems that may be configured in the Siemens
SIMATIC manager. The following steps are required:

Start the Siemens SIMATIC manager and configure a CPU 318-2DP
with the operating mode DP slave.

Connect to Profibus and configure the in-/output area for the slave
section.

Save and compile your project.

Configure another station as CPU 318-2DP with operating mode DP
master.

Connect to Profibus and configure the in-/output area for the master
section

Save and compile your project.

In the following these steps are more detailed.

Project .
engineering of the
slave section

Start the Siemens SIMATIC manager with a new project.
Insert a SIMATIC 300 station and name it as "...DP slave"

Open the hardware configurator and insert a profile rail from the
hardware catalog.

Place the following Siemens CPU at slot 2:
CPU 318-2DP (6ES7 318-2AJ00-0AB0 V3.0)

Connect the CPU to Profibus, set a Profibus address >1 (preferably 3)
and switch the Profibus section via operating mode to "slave operation".

Via Configuration you define the in-/output address area of the slave
CPU that shall be assigned to the DP slave.

Save and compile your project

Slave section

Standard bus Object properties
S|10t Hiodlie Operating mode: DP slave
Connect: Profibus
2 CPU 318-2 L _
X2 DP —p Profibus address: > 1
X1 MPI/DP , .
3 Configuration:
Input area
Output area
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Project » Insert another SIMATIC 300 station and name it as "...DP master".
engineering of the . Qpen the hardware configurator and insert a profile rail from the
master section hardware catalog.

» Place the following Siemens CPU at slot 2:
CPU 318-2DP (6ES7 318-2AJ00-0AB0 V3.0)

* Add your modules according to the real hardware assembly.

e Connect the CPU to Profibus, set a Profibus address >1 (preferably 2)
and switch the Profibus section via operating mode to "master
operation”.

» Connect your slave system to the master system by dragging the "CPU
31x" from the hardware catalog at configured stations onto the master
system and select your slave system.

» Open the Configuration at Object properties of your slave system.

* Via double click to the according configuration line you assign the
according input address area on the master CPU to the slave output
data and the output address area to the slave input data.

» Save and compile your project.

Master section

Standard bus

Slot Module
1
2 CPU 318-2
X2 m=DP DP master system
X1 MPI/DP
?% S7-300 @
{L Hardware catalog: CPU 31x from
“hnn ] configured stations
v
Object properties @
Operating mode: DP master
Connect: Profibus Object properties
Profibus address: > 1 Configuration:

Input area slave CPU = Output area master-CPU
Output area slave CPU = Input area master-CPU

Note!

Data consistency can only be guaranteed for one unit! The choice "Data
consistency by length" is not supported.

4-6
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Project transfer

Overview The following options are available to transfer a project into the CPU 51x
slot card:

 internal via PCI slot (Ethernet connection)

» external via PC network card (routing necessary)
» external via MPI

» external via Profibus (not for first project)

» external via MMC storage card

wn
o
=
b=3
~-
~
wn
o
=1
~
o
=
<
w

EA: 002005730001 g":.‘;t
[

PCI Slot

More about the transfer methods may be found at chapter "Deployment
CPU 51xS" at "Project transfer".
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Profibus installation guidelines

Profibus in
general

Transfer medium

» A Profibus DP network may only be built up in linear structure.

» Profibus DP consists of minimum one segment with at least one master
and one slave.

» A master has always been deployed together with a CPU.
» Profibus supports max. 124 participants.

» Per segment a max. of 32 participants is permitted.

* The max. segment length depends on the transfer rate:

9.6 ... 187.5kbit/s - 1000m
500kbit/s - 400m
1.5Mbit/s - 200m
3 ... 12Mbit/s - 100m

* Max. 10 segments may be built up. The segments are connected via
repeaters. Every repeater counts for one participant.

e All participants are communicating with the same transfer rate. The
slaves adjust themselves automatically on the transfer rate.

* The bus has to be terminated at both ends.
+ Master and slaves are free combinable.

As transfer medium Profibus uses an isolated twisted-pair cable based
upon the RS485 interface.

The RS485 interface is working with voltage differences. Though it is less
irritable from influences than a voltage or a current interface. You are able
to configure the network as well linear as in a tree structure.

Your VIPA CPU includes a 9pin slot "PBDP" where you connect the
Profibus coupler into the Profibus network as a slave.

Max. 32 participants per segment are permitted. The segments are
connected via repeaters. The maximum segment length depends on the
transfer rate.

Profibus DP uses a transfer rate between 9.6kbit/s and 12Mbit/s, the slaves
are following automatically. All participants are communicating with the
same transfer rate.

The bus structure under RS485 allows an easy connection res.
disconnection of stations as well as starting the system step by step. Later
expansions don’'t have any influence on stations that are already
integrated. The system realizes automatically if one partner had a fail down
or is new in the network.
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Chapter 4 Deployment CPU with Profibus

Bus connection

Master

The following picture illustrates the terminating resistors of the respective
start and end station.

Slave Slave
6 \ \ 6
P5V - |- -, [ [ - ¢ - P5V

- Do a o

| | \ \ | |

b330 [ 330 |

L (v \ 'v \ L\"
RxD/TxD-P(B) 3 L | 'l 3 RxD/TxD-P(B) 3 | ! 113 RxD/TxD-P(B)

* ; : .

_ | \ | \ i

e | L

1220 | | | . o220,

| | | |
RXD/TXD-N(A) 8] —1— | ‘ 8 RxD/TxD-N(A) 8 | ‘ ~1”~ |8 RxD/TXD-N(A)

A \ \ hd

o ‘ ! ‘ ! 7

1330 ! ! ! 330,

[ 1 J 1 J [

5 T | | | | B B
M5V - ¢ — - \ | \ | | _ ¢ - M5V
\ i I
| | !

Shield \\.4/ Shield \v/ Shield

EasyConn
bus connector

Note!

The Profibus line has to be terminated with its ripple resistor. Please make
sure to terminate the last participants on the bus at both ends by activating
the terminating resistor.

In systems with more than two stations all partners are wired in parallel.
For that purpose, the bus cable must be feed-through uninterrupted.

Via the order number VIPA 972-0DP10 you may order the bus connector

0° 45° 90°
| |
| 0
é [g
| o)
A A Al
E 0 0 ¢
B B C
0° 45° 90°
A 64 61 66
B 34 53 40
C 15.8 15.8 15.8
all in mm

"EasyConn". This is a bus connector with switchable terminating resistor
and integrated bus diagnostic.
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Termination with
"EasyConn"

Assembly

Please note:

Note!

To connect this EasyConn plug, please use the standard Profibus cable
type A (EN50170). Starting with release 5 you also can use highly flexible
bus cable: Lapp Kabel order no.: 2170222, 2170822, 2170322.

With the order no. 905-6AA00 VIPA offers the "EasyStrip" de-isolating tool
that makes the connection of the EasyConn much easier.

Dimensions in mm

The "EasyConn" bus connector is provided with a switch that is used to
activate a terminating resistor.

Attention!

The terminating resistor is only effective, if the connector
is installed at a slave and the slave is connected to a
power supply.

Note!

A complete description of installation and deployment of
the terminating resistors is delivered with the connector.

* Loosen the screw.

« Lift contact-cover.

¢ Insert both wires into the ducts
provided (watch for the correct
line color as below!)

* Please take care not to cause a
short circuit between screen and
data lines!

* Close the contact cover.

¢ Tighten screw
(max. tightening torque 4Nm).

The green line must be connected to A, the red line to B!

4-10
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Chapter 4 Deployment CPU with Profibus

Commissioning and Start-up behavior

Start-up on
delivery

Online with bus
parameter without
slave project

Slave
configuration

CPU state controls
DP master

Master behavior at
CPU RUN

Master behavior at
CPU RUN

In delivery the CPU is overall reset. The Profibus part is deactivated and its
LEDs are off after Power ON.

The DP master can be served with bus parameters by means of a
hardware configuration. A soon as these are transferred the DP master
goes online with his bus parameter. This is shown by the RUN LED. Now
the DP master can be contacted via Profibus by means of his Profibus
address. In this state the CPU can be accessed via Profibus to get
configuration and DP slave project.

If the master has received valid configuration data, he switches to Data
Exchange with the DP Slaves. This is indicated by the DE-LED.

After Power ON respectively a receipt of a new hardware configuration the
configuration data and bus parameter were transferred to the DP master.

The DP master does not have any operation switch. His state is controlled
by the RUN/STOP state of the CPU.

Dependent on the CPU state the following behavior is shown by the DP
master:

* The global control command "Operate" is sent to the slaves by the
master. Here the DE-LED is ON.

* Every connected DP slave is cyclically attended with an output telegram
containing recent output data.

» The input data of the DP slaves were cyclically transferred to the input
area of the CPU.

» The global control command "Clear" is sent to the slaves by the master.
Here the DE-LED is blinking.

» DP slaves with fail safe mode were provided with output telegram length
"0".

» DP slaves without fail safe mode were provided with the whole output
telegram but with output data = 0.

» The input data of the DP slaves were further cyclically transferred to the
input area of the CPU.
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Chapter 5

Overview

Content

Deployment PtP communication

Content of this chapter is the deployment of the RS485 slot for serial PtP
communication.

Here you'll find all information about the protocols and project engineering
of the interface, which are necessary for the serial communication using
the RS485 interface.

Topic Page
Chapter 5 Deployment PtP communication .........ccccoeeeeeevevieiivnnnnnn. 5-1
Fast introduction...........ooooiiiii i 5-2
Principle of the data transfer ... 5-3
Deployment of RS485 interface for PtP...........ooooviiiiiiii e, 5-4
Parameterization .............o.o oo 5-6
COMMUNICALION ... e 5-9
Protocols and proCcedures ...........ooooiiiiiiiiiiiie e 5-15
Modbus - FUNCHION COAES ......ccoeieiiiiiieiee e 5-19
Modbus - Example communication.............cccooiviiiiiiiiiciiiie e 5-23
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Fast introduction

General

Protocols

Parameterization

Communication

Overview SFCs
for serial
communication

Via a hardware configuration you may de-activate the Profibus part
integrated to the CPU 51xS and thus release the RS485 interface for PtP
(point-to-point) communication.

The RS485 interface supports in PtP operation the serial process
connection to different source res. destination systems.

The protocols res. procedures ASCII, STX/ETX, 3964R, USS and Modbus
are supported.

The parameterization of the serial interface happens during runtime using
the SFC 216 (SER_CFG). For this you have to store the parameters in a
DB for all protocols except ASCII.

The SFCs are controlling the communication. Send takes place via
SFC 217 (SER_SND) and receive via SFC 218 (SER_RCV).

The repeated call of the SFC 217 SER_SND delivers a return value for
3964R, USS and Modbus via RetVal that contains, among other things,
recent information about the acknowledgement of the partner station.

The protocols USS and Modbus allow to evaluate the receipt telegram by
calling the SFC 218 SER_RCV after SER_SND.

The SFCs are included in the consignment of the CPU.

The following SFCs are used for the serial communication:

SFC Description
SFC 216 SER _CFG RS485 parameterize
SFC 217 SER_SND RS485 send
SFC 218 SER_RCV RS485 receive

5-2
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Principle of the data transfer

Overview

Principle

The data transfer is handled during runtime by using SFCs. The principle of
data transfer is the same for all protocols and is shortly illustrated in the
following.

Data, which are written into the according data channel by the PLC, is
stored in a FIFO send buffer (first in first out) with a size of 2x1024byte
and then put out via the interface.

When the interface receives data, this is stored in a FIFO receive buffer
with a size of 2x1024byte and can there be read by the PLC.

If the data is transferred via a protocol, the adoption of the data to the
according protocol happens automatically.

In opposite to ASCII and STX/ETX, the protocols 3964R, USS and Modbus
require the acknowledgement of the partner.

An additional call of the SFC 217 SER_SND causes a return value in
RetVal that includes among others recent information about the
acknowledgement of the partner.

Further on for USS and Modbus after a SER_SND the acknowledgement
telegram must be evaluated by call of the SFC 218 SER_RCV.

RS485 PtP communication

Program

SER_RCV
SFC 218

SER_CFG
SFC 216

SER_SND
SFC 217

Protocol FIFO Buffer Interface
IN RS485
< RECEIVE A 1024Byte
1024Byte 4———
CFG ouT A

A 1024Byte| —»

—»| | 1024Byte
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Deployment of RS485 interface for PtP

Switch to PtP Per default, the RS485 interface X3 of the CPU is used for the Profibus DP

operation master. Via hardware configuration the RS485 interfaces may be switched
to point-to-point communication via the Parameter Function RS485 X3 of
the Properties.

Hardware The hardware configuration happens as described at "Project engineering"
configuration by means of a virtual Profibus master system with the following approach:
Standard bus + Start the Siemens hardware configurator.
| _Slot | Module
1 e Configure the Siemens CPU 318-2AJ00
x22 -ggu 3182 (6ES7 318-2AJ00-0AB0/V3.0).
>§1 | MPIDP____ | » Configure a Siemens CP 343-1 (343-1EX11) for the internal
A ATEXT Ethernet PG/OP channel.
(Ethernet-PG/OP) « Configure always as last module a Siemens DP master CP 342-5
342-5DA02 V5.0 (342-5DA02 V5.0). Connect and parameterize it at operation mode
"DP-Master".
virtual DP master for CPU » Connect the slave system "VIPA_SPEEDbus".
(only for VIPA specific « For the slave system set the Profibus address 100.

object properties)
» Configure at slot 0 the VIPA CPU 51xS of the hardware catalog
from VIPA_SPEEDbus.

CPU: « By double clicking the placed CPU 51xS the properties dialog of
Addr.: 100 the CPU may be opened.
VIPA SPEEDBUS » Switch the Parameter Function RS485 X3 to "PtP".

[Slot__[Order no. |
o CPU 51xS at slot 100

(100) VIPA
. SPEEDbus

As soon as the project is transferred together with the PLC user
program to the CPU, the parameters will be taken after start-up.
Object properties:
Function RS485
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Properties RS485

Connection
RS485

Connection

Logical states represented by voltage differences between the two cores
of a twisted pair cable

» Serial bus connection in two-wire technology using half duplex mode

» Data communications up to a max. distance of 500m

» Data communication rate up to 115.2kbit/s

9pin SubD jack

Pin | Assignment
1 |n.c.
2 |M24Vv
3 |RxD/TxD-P (Line B)
4 |RTS
5 |M5V
6 |P5V
7 | P24V
8 |RxD/TxD-N (Line A)
9 |n.c.
CPU - RS485 Periphery
RXDITXD-P (B) ° RXD/TXD-P (B)
RxD/TxD-N (A) 8 RXD/TxD-N (A)
Shield
o ' T
Periphery
J_ RXD/TxD-P (B)
RXD/TxD-N (A)
4
: : L
Periphery
L RXD/TxD-P (B)
RxD/TxD-N (A)
1
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Parameterization

SFC 216 The parameterization happens during runtime deploying the SFC 216

(SER_CFG) (SER_CFG). You have to store the parameters for STX/ETX, 3964R, USS
and Modbus in a DB.

Name Declaration | Type Comment

Protocol IN BYTE 1=ASCII, 2=STX/ETX, 3=3964R

Parameter IN ANY Pointer to protocol-parameters

Baudrate IN BYTE Number of the baudrate

CharlLen IN BYTE 0=5Bit, 1=6Bit, 2=7Bit, 3=8Bit

Parity IN BYTE 0=None, 1=0dd, 2=Even

StopBits IN BYTE 1=1Bit, 2=1.5Bit, 3=2Bit

FlowControl |IN BYTE 1 (fix)

RetVal ouT WORD Return value (0 = OK)

Parameter All time settings for timeouts must be set as hexadecimal value. Find the

description hex value by multiply the wanted time in seconds with the baud rate.

Example: Wanted time 8ms at a baud rate of 19200Baud
Calculation: 19200bit/s x 0.008s = 154Bit — (9Ah)
Hex value is 9Ah.

Protocol Here you fix the protocol to be used. You may choose between:
1: ASCII
2: STX/ETX
3: 3964R
4: USS Master
5: Modbus RTU Master
6: Modbus ASCII Master
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Parameter (as DB)

Baudrate

CharLen

At ASCII protocol, this parameter is ignored.

At STX/ETX, 3964R, USS and Modbus you fix here a DB that contains the
communication parameters and has the following structure for the
according protocols:

Data block at STX/ETX

DBBO0O: STX1 BYTE (1. Start-ID in hexadecimal)
DBB1: STX2 BYTE (2. Start-ID in hexadecimal)
DBB2: ETX1 BYTE (1. End-ID in hexadecimal)
DBB3: ETX2 BYTE (2. End-ID in hexadecimal)
DBW4: TIMEOUT WORD (max. delay time between 2 telegrams)

Note!

The start res. end sign should always be a value <20, otherwise the sign is
ignored!

With not used IDs please always enter FFh!

Data block at 3964R

DBBO: Prio BYTE (The priority of both partners must be
different)

DBB1: ConnAttmptNr BYTE (Number of connection trials)
DBB2: SendAttmptNr BYTE (Number of telegram retries)
DBW4: CharTimeout WORD (Character delay time)
DBW6: ConfTimeout WORD (Acknowledgement delay time)

Data block at USS
DBWO: Timeout WORD (Delay time in)

Data block at Modbus-Master
DBWO: Timeout WORD (Respond delay time)

Velocity of data transfer in bit/s (Baud).

04h: 1200Baud 05h: 1800Baud 06h: 2400Baud 07h: 4800Baud
08h: 7200Baud  09h: 9600Baud OAh: 14400Baud 0OBh: 19200Baud
0Ch: 38400Baud 0Dh: 57600Baud OEh: 115200Baud

Number of data bits where a character is mapped to.
0: 5Bit 1:6Bit 2: 7Bit  3: 8Bit
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Parity

StopBits

FlowControl

RetVal SFC 216
(Error message
SER_CFG)

The parity is -depending on the value- even or odd. For parity control, the
information bits are extended with the parity bit that amends via its value
("0" or "1") the value of all bits to a defined status. If no parity is set, the
parity bit is set to "1", but not evaluated.

0: NONE 1:0DD 2: EVEN

The stop bits are set at the end of each transferred character and mark the
end of a character.

1: 1Bit 2:1.5Bit  3: 2Bit

The parameter FlowControl is ignored. When sending RST=1, when
receiving RST=0.

Return values send by the block:

Error code |Description

0000h no error

809Ah interface not found

8x24h Error at SFC-Parameter x, with x:

Error at "Protocol"

Error at "Parameter”

Error at "Baudrate"

Error at "CharLength"

Error at "Parity"

Error at "StopBits"

: Error at "FlowControl" (Parameter missing)
809xh Error in SFC parameter value x, where x:
Error at "Protocol"

Error at "Baudrate"

Error at "CharLength"

Error at "Parity"

Error at "StopBits"

Error at "FlowControl"

8092h Access error in parameter DB (DB too short)
828xh Error in parameter x of DB parameter, where x:
1: Error 1. parameter

2: Error 2. parameter

Nk w2

No g how
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Communication

Overview The communication happens via the send and receive blocks SFC 217
(SER_SND) and SFC 218 (SER_RCV).

The SFCs are included in the consignment of the CPU.

SFC 217 This block sends data via the serial interface.

(SER_SND) The repeated call of the SFC 217 SER_SND delivers a return value for
3964R, USS and Modbus via RetVal that contains, among other things,
recent information about the acknowledgement of the partner station.

The protocols USS and Modbus require to evaluate the receipt telegram by
calling the SFC 218 SER_RCV after SER_SND.

Parameter

Name Declaration | Type Comment

DataPtr IN ANY Pointer to Data Buffer for sending data

DataLen ouT WORD Length of data sent

RetVal ouT WORD Return value (0 = OK)

DataPtr Here you define a range of the type Pointer for the send buffer where the
data that has to be sent is stored. You have to set type, start and length.
Example: Data is stored in DB5 starting at 0.0 with a length of

124Byte.
DataPtr:=P#DB5.DBX0.0 BYTE 124

DatalLen Word where the number of the sent Bytes is stored.

At ASCII if data were sent by means of SFC 217 faster to the serial
interface than the interface sends, the length of data to send could differ
from the DatalLen due to a buffer overflow. This should be considered by
the user program.

With STX/ETX, 3964R, Modbus and USS always the length set in DataPtr
is stored or 0.
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RetVal SFC 217
(Error message
SER_SND)

Protocol specific
RetVal values

Return values of the block:

Error code |Description
0000h Send data - ready
1000h Nothing sent (data length 0)
20xxh Protocol executed error free with xx bit pattern for
diagnosis
7001h Data is stored in internal buffer - active (busy)
7002h Transfer - active
80xxh Protocol executed with errors with xx bit pattern for
diagnosis (no acknowledgement by partner)
90xxh Protocol not executed with xx bit pattern for diagnosis (no
acknowledgement by partner)
8x24h Error in SFC parameter x, where x:
1: Error in "DataPtr"
2: Error in "DataLen”
8122h Error in parameter "DataPtr" (e.g. DB too short)
807Fh Internal error
809Ah Interface not found or interface is used for Profibus
809Bh Interface not configured
ASCII
Value Description
9000h Buffer overflow (no data send)
9002h Data too short (OByte)
STX/ETX
Value Description
9000h Buffer overflow (no data send)
9001h Data too long (>1024Byte)
9002h Data too short (OByte)
9004h Character not allowed
3964R
Value Description
2000h Send ready without error
80FFh NAK received - error in communication
80FEh Data transfer without acknowledgement of partner or error
at acknowledgement
9000h Buffer overflow (no data send)
9001h Data too long (>1024Byte)
9002h Data too short (OByte)

5-10
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... Continue USS
RetVal SFC 217 Error code | Description
SER_SND 2000h | Send ready without error
8080h Receive buffer overflow (no space for receipt)

8090h Acknowledgement delay time exceeded
80FO0Oh Wrong checksum in respond

80FEh Wrong start sign in respond

80FFh Wrong slave address in respond

9000h Buffer overflow (no data send)

9001h Data too long (>1024Byte)

9002h Data too short (<2Byte)

Modbus RTU/ASCII Master

Error code |Description

2000h Send ready (positive slave respond)
2001h Send ready (negative slave respond)
8080h Receive buffer overflow (no space for receipt)
8090h Acknowledgement delay time exceeded
80FO0Oh Wrong checksum in respond

80FDh Length of respond too long

80FEh Wrong function code in respond

80FFh Wrong slave address in respond

9000h Buffer overflow (no data send)

9001h Data too long (>1024Byte)

9002h Data too short (<2Byte)
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Principles of
programming

The following text shortly illustrates the structure of programming a send

command for the different protocols.

3964R

SFC 217
SER_SND

J

N

RetVal 8xxxh |
90xxh ? -

N

Retval 2001h ? >J——
RetVal 2000h ? >J
N l

]

Error evaluation

Data evaluation

ASCII / STXIETX

SFC 217
SER_SND

RetVal 900xh J
NL Error evaluation

USS / Modbus

SFC 217
SER_SND

SFC 218
SER_RCV

Error evaluation

RetVal 2001h ? >J
N

RetVal 2000h ? >J

SFC 218
SER_RCV

Data evaluation

L]
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SFC 218 This block receives data via the serial interface.

(SER_RCV) Using the SFC 218 SER_RCYV after SER_SND with the protocols USS and
Modbus the acknowledgement telegram can be read.

Parameter

Name Declaration | Type Comment

DataPtr IN ANY Pointer to Data Buffer for received data

DataLen ouT WORD Length of received data

Error ouT WORD Error Number

RetVal ouT WORD Return value (0 = OK)

DataPtr Here you set a range of the type Pointer for the receive buffer where the
reception data is stored. You have to set type, start and length.
Example: Data is stored in DB5 starting at 0.0 with a length of 124Byte.

DataPtr:=P#DB5.DBX0.0 BYTE 124

DatalLen Word where the number of received Bytes is stored.
At STX/ETX and 3964R, the length of the received user data or O is
entered.
At ASCII, the number of read characters is entered. This value may be
different from the read telegram length.

Error This word gets an entry in case of an error. The following error messages
may be created depending on the protocol:
ASCII
Bit | Error Description

0 |overrun Overflow, a sign couldn’t be read fast enough from the
interface

1 |framing error |Error that shows that a defined bit frame is not
coincident, exceeds the allowed length or contains an
additional Bit sequence (Stopbit error)

2 | parity Parity error
3 |overflow Buffer is full
STX/ETX
Bit | Error Description
0 |overflow The received telegram exceeds the size of the receive
buffer.
1 |char A sign outside the range 20h...7Fh has been received.
3 |overflow Buffer is full

3964R / Modbus RTU/ASCII Master

Bit | Error Description
0 |overflow The received telegram exceeds the size of the receive
buffer.
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RetVal SFC 218 Return values of the block:
(Error message
SER_RCV) Error code |Description

0000h no error

1000h Receive buffer too small (data loss)

8x24h Error at SFC-Parameter x, with x:

1: Error at "DataPtr"

2: Error at "DatalLen"

3: Error at "Error"

8122h Error in parameter "DataPtr" (e.g. DB too short)

809Ah Serial interface not found res. interface is used by Profibus
809Bh Serial interface not configured

Principles of The following picture shows the basic structure for programming a receive
programming command. This structure can be used for all protocols.

SFC 218
SER_RCV

RetVal 0000h ?

N

RetVal 8xo¢h ?

Data evaluation

Error evaluation
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Protocols and procedures

Overview

ASCII

STX/ETX

The CPU supports the following protocols and procedures:
» ASCII communication

o« STX/ETX

* 3964R

+ USS

* Modbus

ASCII data communication is one of the simple forms of data exchange.
Incoming characters are transferred 1 to 1.

At ASCII, with every cycle the read-SFC is used to store the data that is in
the buffer at request time in a parameterized receive data block. If a
telegram is spread over various cycles, the data is overwritten. There is no
reception acknowledgement. The communication procedure has to be
controlled by the concerning user application.

STX/ETX is a simple protocol with start and end ID, where STX stands for
Start of Text and ETX for End of Text.

The STX/ETX procedure is suitable for the transfer of ASCII characters. It
does not use block checks (BCC). Any data transferred from the periphery
must be preceded by a start followed by the data characters and the end
character.

Depending of the byte width the following ASCIl characters can be
transferred: 5Bit: not allowed: 6Bit: 20...3Fh, 7Bit: 20...7Fh, 8Bit: 20...FFh.
The effective data, which includes all the characters between Start and End
are transferred to the PLC when the End has been received.

When data is send from the PLC to a peripheral device, any user data is
handed to the SFC 217 (SER_SND) and is transferred with added Start-
and End-ID to the communication partner.

Message structure:

STX1 — STX2 — 21 — 22 Zn — ETX1 — ETX2 —

—ZVZ<—

You may define up to 2 Start- and End-IDs.

You may work with 1, 2 or no Start- and with 1, 2 or no End-ID. As Start-
res. End-ID all Hex values from 01h to 1Fh are permissible. Characters
above 1Fh are ignored. In the user data, characters below 20h are not
allowed and may cause errors. The number of Start- and End-IDs may be
different (1 Start, 2 End res. 2 Start, 1 End or other combinations). If no
End-ID is defined, all read characters are transferred to the PLC after a
parameterizable character delay time (Timeout).
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3964R The 3964R procedure controls the data transfer of a point-to-point link
between the CPU and a communication partner. The procedure adds
control characters to the message data during data transfer. These control
characters may be used by the communication partner to verify the
complete and error free receipt.

The procedure employs the following control characters:

« STX Start of Text

« DLE Data Link Escape

« ETX End of Text

« BCC Block Check Character
« NAK Negative Acknowledge

Procedure Active partner Passive partner

STX ~=—————P
Monitor delayed acknowledgment
<4—— DLE
Message-data —_—
DLE —Pp

ETX e
BCC ————

Monitor delayed acknowledgment

You may transfer a maximum of 255Byte per message.

Note!

When a DLE is transferred as part of the information it is repeated to
distinguish between data characters and DLE control characters that are
used to establish and to terminate the connection (DLE duplication). The
DLE duplication is reversed in the receiving station.

The 3964R procedure requires that a lower priority is assigned to the
communication partner. When communication partners issue simultaneous
send commands, the station with the lower priority will delay its send
command.
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USS

Broadcast with set
bit 5 in ADR-Byte
7 6 5 4 3 2

1

1

0

[
Broadcast

The USS protocol (Universelle serielle Schnittstelle = universal serial
interface) is a serial transfer protocol defined by Siemens for the drive and
system components. This allows to build-up a serial bus connection
between a superordinated master and several slave systems.

The USS protocol enables a time cyclic telegram traffic by presetting a fix
telegram length.

The following features characterize the USS protocol:
*  Multi point connection
» Master-Slave access procedure
» Single-Master-System
* Max. 32 participants
» Simple and secure telegram frame

You may connect 1 master and max. 31 slaves at the bus where the single
slaves are addressed by the master via an address sign in the telegram.
The communication happens exclusively in half-duplex operation.

After a send command, the acknowledgement telegram must be read by a
call of the SFC 218 SER_RCV.

The telegrams for send and receive have the following structure:

Master-Slave telegram

STX |LGE | ADR PKE IND PWE STW HSW | BCC

02h H]L|HJ]L[H]JL|[H]JL|[HIL

Slave-Master telegram

STX|LGE | ADR PKE IND PWE ZSW HIW BCC
02h H]L|HJ]L[H]JL|[H]JL|[HIL
where STX: Start sign STW: Control word

LGE: Telegram length ZSW: State word

ADR: Address HSW: Main set value

PKE: Parameter ID HIW: Main effective value

IND: Index BCC: Block Check Character

PWE: Parameter value

A request can be directed to a certain slave ore be send to all slaves as
broadcast message. For the identification of a broadcast message you
have to set bit 5 to 1 in the ADR-Byte. Here the slave addr. (bit 0 ... 4) is
ignored. In opposite to a "normal" send command, the broadcast does not
require a telegram evaluation via SFC 218 SER_RCV. Only write
commands may be sent as broadcast.
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Modbus

Broadcast with
slave address = 0

ASCIIl, RTU mode

Supported Modbus
protocols

The Modbus protocol is a communication protocol that fixes a hierarchic
structure with one master and several slaves.

Physically, Modbus works with a serial half-duplex connection.

There are no bus conflicts occurring, because the master can only
communicate with one slave at a time. After a request from the master, this
waits for a preset delay time for an answer of the slave. During the delay
time, communication with other slaves is not possible.

After a send command, the acknowledgement telegram must be read by a
call of the SFC 218 SER_RCV.

The request telegrams send by the master and the respond telegrams of a
slave have the following structure:

Start Slave Function Data Flow End
sign address |Code control |sign

A request can be directed to a special slave or at all slaves as broadcast
message. To mark a broadcast message, the slave address 0 is used.

In opposite to a "normal" send command, the broadcast does not require a
telegram evaluation via SFC 218 SER_RCV.

Only write commands may be sent as broadcast.

Modbus offers 2 different transfer modes:

» ASCIlI mode: Every Byte is transferred in the 2 sign ASCII code. The
data are marked with a start and an end sign. This causes a transparent
but slow transfer.

* RTU mode: Every Byte is transferred as one character. This enables a
higher data pass through as the ASCIlI mode. Instead of start and end
sign, a time control is used.

The mode selection happens during runtime by using the SFC 216 SER_CFG.
The following Modbus Protocols are supported by the RS485 interface:

e Modbus RTU Master
* Modbus ASCII Master

5-18
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Modbus - Function codes

Naming
convention

Range definitions

Modbus has some naming conventions:

Bit = IN: "Input Status"
Coil OUT: "Coil Status"

Word = | IN: "Input Register"
Register | OUT: "Holding Register"

* Modbus differentiates between bit and word access;
Bits = "Coils" and Words = "Register".

» Bit inputs are referred to as "Input-Status" and Bit outputs as "Coil-
Status".

 Word inputs are referred to as "Input-Register" and Word outputs as
"Holding-Register".

Normally the access at Modbus happens by means of the ranges 0x, 1x, 3x
and 4x.

Ox and 1x gives you access to digital Bit areas and 3x and 4x to analog
word areas.

For the CPs from VIPA is not differentiating digital and analog data, the
following assignment is valid:

Ox:

1x:

3x:

4x:

ouT

Bit area for master output data

Access via function code 01h, 05h, OFh
Bit area for master input data

Access via function code 02h

Word area for master input data
Access via function code 04h

Word area for master output data
Access via function code 03h, 06h, 10h

——— 1x0001

——— 1x0002 1x0022
1x0003
HLEEEEEEEEEEEEE EEEEREEEEEEEEEEE EEEEEEEEEEEEEEEN
3x0001 3x0002 3x0003
0x0001
0x0002 0x0022
0x0003
HLEEEEEEEEEEEEE EEEEREEEEEEEEEEE EEEEEEEEEEEEEEEN
4x0001 4x0002 4x0003

A description of the function codes follows below.
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Overview

Point of View of
"Input" and
"Output" data

With the following Modbus function codes a Modbus master can access a
Modbus slave. The description always takes place from the point of view of
the master:

Code |Command Description
01h Read n Bits Read n Bits of master output area 0x
02h Read n Bits Read n Bits of master input area 1x

03h Read n Words Read n Words of master output area 4x
04h Read n Words Read n Words master input area 3x

05h Write 1 Bit Write 1 Bit to master output area 0x
06h Write 1 Word Write 1 Word to master output area 4x
OFh Write n Bits Write n Bits to master output area 0x

10h Write n Words Write n Words to master output area 4x

The description always takes place from the point of view of the master.
Here data, which were sent from master to slave, up to their target are
designated as "output" data (OUT) and contrary slave data received by the
master were designated as "input" data (IN).

System 200V - Slave Periphery
PtP ‘ CPU
System 5008 - Master
CPU ‘ PtP ouT
write (05h,0F:bit, 06h10h:word) > ox(bit) » RECEIVEFC1| oOuT » ouT
ouT read (01h:bit, 03h:word) 4x(word)
IN
IN read (02h:bit, 04h:word) 1x(bit) < SEND FCO N €—— IN
3x(wort)

Respond of the
slave

Byte sequence
in a Word

Check sum CRC,
RTU, LRC

If the slave announces an error, the function code is send back with an
"ORed" 80h. Without an error, the function code is sent back.

Slave answer: Function code OR 80h - Error
Function code - OK
For the Byte sequence in a Word is always valid: 1 Word
High Low
Byte Byte

The shown check sums CRC at RTU and LRC at ASCIl mode are
automatically added to every telegram. They are not shown in the data
block.

5-20
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Read n Bits
01h, 02h

Code 01h: Read n Bits of master output area 0x
Code 02h: Read n Bits of master input area 1x

Command telegram

Slave address | Function code |Address Number of Check sum
1. Bit Bits CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
Respond telegram
Slave address | Function code | Number of Data Data Check sum
read Bytes 1. Byte 2. Byte CRC/LRC
1Byte 1Byte 1Byte 1Byte 1Byte 1Word
max. 250Byte
Read n Words 03h: Read n Words of master output area 4x
03h, 04h 04h: Read n Words master input area 3x
Command telegram
Slave address | Function code |Address Number of Check sum
1. Bit Words CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
Respond telegram
Slave address | Function code | Number of Data Data Check sum
read Bytes 1. Word 2. Word CRC/LRC
1Byte 1Byte 1Byte 1Word 1Word 1Word
max. 125Words
Write 1 Bit Code 05h: Write 1 Bit to master output area Ox
05h A status change is via "Status Bit" with following values:
"Status Bit" = 0000h - Bit=0
"Status Bit" = FFOOh - Bit =1
Command telegram
Slave address | Function code |Address Status Check sum
Bit Bit CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
Respond telegram
Slave address | Function code |Address Status Check sum
Bit Bit CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
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Write 1 Word
06h

Write n Bits OFh

Code 06h: Write 1 Word to master output area 4x

Command telegram

Code OFh: Write n Bits to master output area 0x

Slave address | Function code |Address Value Check sum
word word CRC/LRC
1Byte 1Word 1Word 1Word
Respond telegram
Slave address | Function code |Address Value Check sum
word word CRC/LRC
1Byte 1Word 1Word 1Word

Please regard that the number of Bits has additionally to be set in Byte.

Command telegram

Slave address | Function Address Number of | Number of Data Data Check sum
code 1. Bit Bits Bytes 1. Byte 2. Byte ... |CRC/LRC
1Byte 1Byte 1Word 1Word 1Byte 1Byte 1Byte 1Byte 1Word
max. 250Byte
Respond telegram
Slave address | Function code | Address Number of Check sum
1. Bit Bits CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
Write n Words 10h  Code 10h: Write n Words to master output area 4x
Command telegram
Slave address | Function Address Number of | Number of |Data Data Check sum
code 1. Word words Bytes 1. Word |2. Word CRC/LRC
1Byte 1Byte 1Word 1Word 1Byte 1Word 1Word 1Word 1Word
max. 125 Words
Respond telegram
Slave address | Function code | Address Number of Check sum
1. Word Words CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
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Modbus - Example communication

Outline The example establishes a communication between a master and a slave
via Modbus. The following combination options are shown:

Modbus master (M) Modbus slave (S)
CPU 51xS

CPU 21xSER-1

Components The following components are required for this example:

CPU 51xS as Modbus RTU master

CPU 21xSER-1 as Modbus RTU slave

Siemens SIMATIC Manager and possibilities for the project transfer
Modbus cable connection

Approach .

Assemble a Modbus system consisting of a CPU 51xS as Modbus
master and a CPU 21xSER-1 as Modbus slave and Modbus cable.

Execute the project engineering of the master!
For this you create a PLC user application with the following structure:

OB 100:

OB 1:

Call SFC 216 (configuration as Modbus RTU master) with
timeout setting and error evaluation.

Call SFC 217 (SER_SND) where the data is send with error
evaluation. Here you have to build up the telegram according
to the Modbus rules.

Call SFC 218 (SER_RECV) where the data is received with
error evaluation.

Execute the project engineering of the slave!
The PLC user application at the slave has the following structure:

OB 100:

OB 1:

Call SFC 216 (configuration as Modbus RTU slave) with
timeout setting and Modbus address in the DB and error
evaluation.

Call SFC 217 (SER_SND) for data transport from the slave
CPU to the output buffer.

Call SFC 218 (SER_RECV) for the data transport from the
input buffer to the CPU. Allow an according error evaluation
for both directions.

The following page shows the structure for the according PLC programs for
master and slave.
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Master

CPU 51xS

‘ Master

Slave

CPU 21xSER-1

Slave ‘ CPU

— SER_RCV

L —» RetVal

—

«€— SER_SND

CPU
| SER_SND | code/data
]
| SERRCV — T
]
l
\ code '
| SER_SND | '
!
| SERRCV < —

0OB100:

SFC 216
SER_CFG
(DB: Timeout)

L —» RetVal

SFC 216

SER_CFG
(DB: Timeout, slave address)

N

OB1:

SFC 217
SER_SND

(mit Slave-Nr., Code,

Bereich)

RetVal 700xh?
N RetVal 9001h 2>>J
N
etVal 8xxxh - ¢

N RetVal 0000h ? >J—
N
L

RetVal 2001h ? >-J———

N
RetVal 2000h ? 3
N N
RetVal 0000h ? >J
J “

N- Data evaluation

N
J
:

it

SFC 217
SER_SND

SFC 218
SER_RCV

SFC 218
SER_RCV

SER_SND
RetVal 2001h

RetVal 8xxxh ?
N
L

L
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Chapter 6 Deployment PLC-Tool

Overview This chapter contains the description of the control software PLC-Tool from
VIPA. PLC-Tool is a component of the OPC-Server package and is
installed together with the OPC server at the standard installation.

The OPC-Server package can be found at the enclosed CD SW-

ToolDemo.
Content Topic Page
Chapter 6  Deployment PLC-TOO!.......ccuvviiiiiiieeiieiiee e, 6-1
L T=T =T = | 6-2
Setup and run of Program ..........ccoeeiiiiiiiiii s 6-3
PLC-Tool Operation ............cooeeuiiieiiiieeeeeeeeee et 6-4
Deployment PLC-TOO ........ooiiiiiiiiiiee e 6-7
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General

Overview

PLC-Tool

Tray-lcon

WD 132

PLC-Tool is a program for operating the CPU 51xS.

The OPC-Server is required for communicating with the CPU. The OPC-
Server has to be installed on the PC. The PLC-Tool enables you to "talk” to
external CPUs which are connected via MPI to the serial interface of the
PC.

x

File ©CPU Options 7

FLC FE-t4

H PR EFRUN
RN MEFRF

W 5T0OF WCE

B 5F

W MMC

B FRCE

RLIM
STOP

The operating surface (see figure above), which is a schematically top view
of a CPU, serves for monitoring and operating the CPU. Here, the status of
the LEDs on the CPU as well as the position of the mode switch are
shown.

When starting the program, it installs itself also as a small icon (Tray-Icon)
in the windows tool bar.

The Tray-lcon also visualizes the status of the CPU. This example here
shows the CPU in run ¥ status. The program can be started repeatedly in
order to simultaneously operate and monitor several CPUs. For each
connection to a CPU, you have to assign an own MPI-address.

Any other trademarks referred to in the text are the trademarks of the
respective owner and we acknowledge their registration.
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Setup and run of program

System
requirements

Requirements

Setup

Run of program

For deployment of the PLC-Tool on your PC there are the following system
requirements:

» PC with Windows operating system (Windows 2000 or higher, Windows
XP professional or Windows NT 4.0 Service package 6)

+ atleast 32MB work memory (64MB are recommended)

 for installation about 10MB for OPC-Server and PLC-Tool

The installation of the OPC-Server is required when using PLC-Tool, as the
required drivers for the PLC-Tool will be installed on your PC by installing
the OPC-Server.

As the PLC-Tool is a component of the OPC-Server package, the PLC-
Tool will be installed together with the OPC-Server during the standard
setup.

The PLC-Tool can also be installed separately. Like installing the OPC-
Server, the installation of the PLC-Tool is supported by a setup-program.

Close all Windows-programs before starting the setup-program.

Insert the CD SW-Tool/Demo. The overview will be loaded via the auto-
start function of the CD. From now on, you will be guided through the
installation.

PLC-Tool can be opened like any other PC-application. You have three
options:

Start menu

In windows start menu, please click OPC! Then click on PLC-Tool!

Explorer

You can start the PLC-Tool by double clicking on file: VPLCTool.exe in
directory C:\Programs\OPC Server.

Tool bar via Tray-lcon

As soon as PLC-Tool has been started, tray-icon (mini symbol) is shown in
the start tool bar.

PLC-Tool can be opened by double clicking onto that tray-icon.
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PLC-Tool Operation

Operating Dialog

Open operating
dialog

Main menu

Name of the PLC
system

Status indicators

Operating mode
switch

The operating dialog will be opened after starting the program.

x

FLC PB-h4
o o W RUN Status indicator
Status indicator RN W ERR Profibus master
CPU W STOF
B 5F
| MMC ] Hardware release
B FRCE Firmware release
RUM
Operating modes I A

CPU Selection of operating

modes

M-RES

The menu of the program consists of the following entries:

File CPU Options ?(Help)
- Minimize - New connection ... - Language - Content
- Exit - Connection diagnosis ... - Create link - Help index
- Download WLD file - Always on top - Use help
- Info

Here, the name of your PLC system is shown. You can enter the name into
the dialog box CPU > New connection.

The LED states of the corresponding CPU are copied into the status
indicators. The set up of the status indicator depends on the CPU in use.
As long as there is not a connection to the CPU, the status indicator is
deactivated. Additionally, there is a status indication in the tool bar of your
windows-system (tray-icon).

The push buttons which are accordingly to the operating mode either
activated or deactivated, serve for adjusting the operating mode of the
CPU. Additionally the physical status of the operating mode switch is
shown on the desk top in form of a switch.

6-4
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Structure of
menu

File

CPU

Options

Minimize
By using the command ,minimize“ the operating dialog will be closed.

The program continues actively and will be stored as icon (tray-icon) on the
tool bar.

Exit
Herewith, the program will be stopped and the tray-icon deleted from the
tool bar.

New connection

With this command a dialog box will be opened. You can specify your
connection to the CPU within this dialog box.

Connection diagnosis

When using this command a dialog box is opened which gives information
regarding the effective connection.

Download WLD file
This function allows you to transfer wid files to the module.

Language

When marking this command, a submenu containing a list of available
languages for the surface is being opened. The active language is marked
with a hook. The language on the program surface can be changed by
clicking on another language.

Note!

As long as your operating system does not support languages, these
languages will be shown as deactivated. The languages do exist but it is
not possible to choose them.

Create link

Via setting up a link you can set up a link for your CPU connection which is
momentarily active. In the dialog box you have to mention where you
stored it.

Always on top

This function always puts the operating dialog onto the top level of the
monitor. Therewith, the window is always visible, even then, when you are
working with different applications. This function is marked with a hook, if
active. By clicking anew onto that function — it can be deactivated again.
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? (Help)

Content
This command opens an overview with topics of online-support.

Help Index

This command offers the option to have all catchwords regarding
information for support alphabetically indicated. In that list you can go up
and down by using the arrow-keys and stop at the word you are looking for
to mark it. After having marked that word the appropriate text for help will
be shown.

Use help

This function opens a window with standard-help for windows. Here, you
can obtain information for using the help system.

Info

Via information you will obtain details about revision date of the PLC-Tool
and copyright.

6-6
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Chapter 6 Deployment PLC-Tool

Deployment PLC-Tool

Establish
connection to
the CPU

Name of adapter

Description

Local IP address

PLC IP address

Slot number
(Rack)

Finish

With CPU > New connection the dialog window "Create new adapter" is
opened.

To access the CPU 51xS set Connection type to "Ethernet". The following
dialog window is opened.

Cornection tupe ainel
g
Wy
Mame of adspher Jadapterl
Dessiiption
Local IP address
FLC IF addess

Slat number [Rack] [2 -

Create link [~

Concel

Please enter here an unique name! The name should signify the PLC
system in which your CPU is, e.g. "mixer".

Into this dialog box, you may enter an additional description, which explains
your system more specifically. The assigned name in here will be given as
tool-tip. If you don'’t assign a description — then the name of the adapter will
be given as "tool-tip".

The initialization by PLC function can only be established if Siemens
SIMATIC manager and CPU 51xS slot card are at the same PC.

If the CPU 51xS slot card and PLC-Tool are at the same PC please enter
here the IP address of the Ethernet part of the CPU 51xS.

If you want to access the CPU 51xS from an external PC via Ethernet, so
you have to enter the IP address of the network card of the external PC.
Additionally you have to set the routing to the CPU 51xS slot card in the
target PC and to enter this route in the external PC. More concerning this
may be found at "External access to PG/OP channel via routing".

Please enter here the IP address of the CPU part of the slot card
Leave this parameter at 2.

By clicking at [Finish] a connection to your CPU is established.
Note!

The adjustments made in the dialog box are only of temporary existence.

As soon as you close the PLC-Tool, your entries will be deleted. For
securing your settings you should secure your data in form of a link via
options > create link.
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Connection
diagnosis
Dialog box The following dialog box will be opened under CPU > connection diagnosis:
Informations on PLC connection Mixer K|
@ Informations on PLC connection Mixer
¥ Update
Date/Time (GMT)l Ewvent | Module
) 04.02.2002 10:02:09 (+ 377 ms) Connection to Connection Communication Server s being established D:iheine DateienyKunden®
2k 14.02.2002 10:02:09 {+ 377 ms) Connection estaklished. DiyMeine Dateien\Kunden'
€ 04.02.2002 10:02:09 (+ 377 ms) Temporary adapter objectis being created. D:iMeine Dateienykunden®
ok 14.02.2002 10:02:09 {+ 387 ms) Adapter object created. DiyMeine DateienKunden'
€ 04.02.2002 10:02:09 (+ 387 ms) Connection to PLC is being established D Meine DateienyKunden®
9% 14.02.2002 10:02:09 {+ 728 rms) Connection estaklished. DiyMeine DateienKunden'
€ 04.02.200210:02:11 (+ 380 ms) The status of all LEDs is being read out PLC). D Meine DateienyKunden®
‘2}’ 04.02.2002 10:02:17 (+ 490 ms) Readout of the status of the LED has been successful. DiyMeine Dateien\Kunden'
(0402 2002 100211 (+ 490 5] Itis not possible to find ewvery LED-status by reading the complete list Thisisw . DriMeine DateignyKundent
0 04.02.2002 10:02:17 (+ 490 ms) The status of LED PLC-DESL is being read out, C:yMeine Dateien'\Kunden®
(T 0402 2002 100211 (+ B31 ms) Readout of the status of the LED failed. The CPU does not supportthe carmma . DryMeine DateienyKundent
= Error code of the PLC: 0x0000030c
€ 04.02.2002 10:02:15 (+ 777 ms) The status of all LEDs is being read out FLC). D Meine Dateien'Kunden®
2k 0402 2002 10:02:15 (+ 887 ms) Feadout of the status of the LED has bheen successiul. D:iheine DateienyKunden®
() 04.02.2002 10:02:15 (+ 897 ms) iz not possible to find every LED-status by reading the complete list Thisisw.. D:\Meine DateieniKunden:
€ 04.02.2002 10:02:15 (+ 897 ms) The status of LED PLC-DESL is being read out D:iMeine Dateienykunden®
(T 04.02.2002 10:02:16 (+ 17 ms) Readout of the status of the LED failed. The CPU does not suppartthe comma...  DiyMeine DateienyKunden?
= Error code of the PLC: 0x0000030c
4 |
This dialog box gives information about the effective connection.
Protocol of Similar to the event protocol of windows, for indicating diagnosis data three
Procedures procedure modes are used and are shown via a proper symbol.
The symbols have the following meaning:
ok A procedure was successfully finished.
3] A procedure is in process.
(M While in process, an error has occured.
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Create link

Dialog box

Link directory

Adapter

Language

Hidden (as icon
shown in the tool
bar)

When clicking Options > create link you reach a dialog box setting up a
link. By starting the program via that link the PLC-Tool is being started and
is automatically setting up the stored connection.

Create link £ |

Directary far the link

Start-up [all uzers) j

Adapter

I <Current connechion: ;I
Language

| Englist: Englisch [US4) |

[ Hidden [a2 icon in the task barl

[T Alwaps on top

| Finizh I Cancel

It's possible to enter the following inputs for the link which has to be
created.

By clicking on the arrow a list with different options is being opened — it
contains various directories out of the start menu as well as the desk top.
Choose the requested file for the link with your mouse.

Via entry ,another folder” you can insert any other file for the link. For this,
a standard dialog for a new folder is being opened.

Via this selection-list you can see the connections already set up. This list
is equivalent to the list in menu CPU.

In this selection-list you can find the connections already set up. You can
also find this list in the connection-dialog box.

In the menu options > language various languages are listed. Via selection
list you have the option to choose one of these languages you prefer for
the link and confirm it by mouse click.

By clicking this option it is reached that the program, when started via the
link, will not me maximized but will only be started as icon in the tool bar.
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Always on top

Change of
operating mode

Operating mode
switch

O
e
O

Push buttons

RUM

STOP

M-RES

i

This option enables this program, when being started via the link, always to
be atop all other programs on the monitor.

Note!

By saving your link in autostart (all users) with a setting ,hidden“ the PCL-
Tool is being started and secured as tray icon on the tool bar as soon your
windows system is getting started.

The effective operation mode is indicated by LEDs.

The effective position of the operating mode switch on the CPU is
visualized by a graphic in the PLC-Tool.

The switch has the following positions:
The CPU is in run modus.
The CPU is in stop modus.

M-Res (overall reset) — the CPU is in overall reset modus.

Next to the operating mode switch there are three push buttons with which
the CPU can be positioned into the proper operation mode.

The following push buttons can be operated:

The CPU will be set into run modus.

The CPU will be set into run modus.

The CPU will be set into overall reset modus.

Note!

The push buttons are released or disabled for operation depending on the
current operating mode (LED) and the effective position of the operating
mode switch. Thereby, you can only use the push buttons which are
suggestive for the current situation at a time.

6-10
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Tray-lcon

WD 132

¢ @ m <

Tool tip

Each entity of the program installs itself after starting as tray icon located in
the windows-toolbar. When having finished the program, the tray icon will
be deleted.

The tray icon has the following formats, according to the operating
mode of the CPU:

CPU is in run modus
CPU is in start-up (changing from stop into run).
CPU is in stop modus

Status of CPU unknown (no connection).

When strolling over the tray icon with the mouse a small information
window (tool tip) with the name of the adapter will be displayed.

The dialog is being opened by double-clicking on the symbol.

Right mouse click onto the symbol opens a menu via which the dialog can
be called.

Besides, finishing of the program is offered via the menu.

HB145E - CPU - RE_517-2AJ02 - Rev. 10/23 6-11



Chapter 6 Deployment PLC-Tool Manual VIPA System 500S SPEED7

Status indication

LEDs For status indication, the PLC-Tool has LED-rows for the CPU and for the
Profibus master. Use and the proper colors are to be found in below
mentioned columns. For a detailed description of the LEDs, please refer to
the manual for the respective CPU!

Not all LEDs listed below have to be always indicated. In fact, the PLC-Tool
indicates the LEDs only which enable the PLC-Tool to read information
from the CPU.

Status LEDs CPU Description Color Meaning

PWR yellow CPU is supplied with voltage.

RUN green CPU is in run-status. If LED flashing, CPU is
in start up.

STOP red CPU is in STOP status.

SF red Lights up when system error occurs

MMC red Flashes when access to MMC

FRCE yellow Lights up as soon as variables are fixed.

DESL yellow Indicates Profibus slave activity as long as the

integrated Profibus master is activated.

Status of LEDs Description Color Meaning
Profibus master
RUN green  Profibus master in operation. If LED flashes,
Profibus master in start-up.
ERR red Lights up when breakdown of slave
DE yellow DE (Data exchange) indicates communication
via Profibus
IF red Initializing error when parameterization is faulty
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Chapter 7 WinPLC7

Overview In this chapter the programming and simulation software WinPLC7 from
VIPA is presented. WIinPLC7 is suited for every with Siemens STEP®7
programmable PLC.

Besides the system presentation and installation here the basics for using
the software is explained with a sample project.

More information concerning the usage of WinPLC7 may be found in the
online help respectively in the online documentation of WinPLC?7.

Content Topic Page
Chapter 7 WINPLCT ... 7-1

System presentation...........oo i 7-2

INSEAIALION ... 7-3

Example project engineering ............oooooiiiiiiiiiiiiii e 7-4
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System presentation

General WiInPLC7 is a programming and simulation software from VIPA for every
PLC programmable with Siemens STEP®7.
This tool allows you to create user applications in FBD, LAD and STL.
Besides of a comfortable programming environment, WinPLC7 has an

integrated simulator that enables the simulation of your user application at
the PC without additional hardware.

This “Soft-PLC” is handled like a real PLC and offers the same error
behavior and diagnosis options via diagnosis buffer, USTACK and
BSTACK.

Note!

Detailed information and programming samples may be found at the online
help respectively in the online documentation of WinPLC?7.

Alternatives There is also the possibility to use the Siemens SIMATIC manager instead
of WinPLC7 from VIPA. Here the proceeding is part of this manual.

System * Pentium with 233MHz and 64Mbyte work space
requirements « Graphics card with at least 16bit color - we recommend a screen
resolution of at least 1024x768 pixel.

» Windows 98SE/ME, Windows 2000,
Windows XP (Home and Professional), Windows Vista

Source You may receive a demo version from VIPA. Without any activation with
the demo version the CPUs 11x of the System 100V from VIPA may be
configured.

To configure the SPEED7 CPUs a license for the "profi" version is
necessary. This may be online received and activated.

There are the following sources to get WinPLC7:

Online At www.vipa.de in the service area at Downloads a link to the current demo
version and the updates of WinPLC7 may be found.

CD Order no. Description

SW211C1DD |WinPLC7 Single license, CD, with documentation in german

SW211C1ED |WinPLC7 Single license, CD, with documentation in english

SW900TOLA | ToolDemo
VIPA software library free of charge respectively demo
versions, which may be activated
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Installation

Preconditions

Installation
WinPLC7
Demo

Activation of the
"Profi" version

Installation of
WinPCAP for
station search via
Ethernet

The project engineering of a SPEED7 CPU from VIPA with WinPLC7 is
only possible using an activated "Profi" version of WinPLC7.

The installation and the registration of WinPLC7 has the following
approach:

For installation of WinPLC7 start the setup program of the
corresponding CD respectively execute the online received exe file.

Choose the according language.
Agree to the software license contract.

Set an installation directory and a group assignment and start the
installation.

Start WinPLC7. A "Demo" dialog is shown.
Press the <g> key. The following dialog for activation is shown:

Activating program

Email-Adr.: -
Your name: &

[
EYE-LCLIPLCTTY &
-

e e e b e ‘ This pes have no aceess t the intetnet

= Nocessary details

Fill in the following fields:
Email-Addr., Your Name und Serial number. The serial number may be
found on a label at the CD case.

If your computer is connected to Internet you may online request the
Activation Key by [Get activation key via Internet]. Otherwise click at
[This PC has no access to the internet] and follow the instructions.

With successful registration the activation key is listed in the dialog
window respectively is sent by email.

Enter the activation key and click to [OK]. Now, WinPLC?7 is activated as
"Profi" version.

To find a station via Ethernet (accessible nodes) you have to install the
WiInPCAP driver. This driver may be found on your PC in the installation
directory at WinPLC7-V4/WinPcap_4 0.exe.

Execute this file and follow the instructions.
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Example project engineering

Job definition In the example a FC 1 is programmed, which is cyclically called by the
OB 1. By setting of 2 comparison values (valuel and value2) during the FC
call, an output of the PLC-System should be activated depending on the
comparison result.

Project For the output in the simulator the following should apply:
engineering for if valuel = value2 activate output Q 124.0

deployment in if valuel > value2 activate output Q 124.1

the simulator if valuel < value2 activate output Q 124.2

Precondition * You have administrator rights for your PC.

 WiInPLCY7 is installed and activated as "Profi" version.

Hardware For the exclusive deployment in the simulator no hardware configuration is
configuration necessary.

Programming of The PLC programming happens by WinPLC7.
theFC1 « Start WinPLC7 ("Profi" version)
» Create and open a new project by File > Open/create a project.

Creating block FC 1 « Choose File > Create new block.
» Enter "FC1" as block and confirm with [OK]. The editor for FC 1 is

called.
Creating In the upper part of the editor there is the parameter table. In this example
parameters the 2 integer values valuel und value2 are to be compared together. Since

both values are read only by the function, these are to be defined as "in".
» Select the "in -->" row at the parameter table and enter at the field

Name "value1". Press the [Return] key. The cursor jumps to the column
with the data type.

» The data type may either directly be entered or be selected from a list of
available data types by pressing the [Return] key. Set the data type to
INT and press the [Return] key. Now the cursor jumps to the Comment
column.

» Here enter "1. compare value" and press the [Return] key. A new "in -->"
row is created and the cursor jumps to Name.

* Proceed for value2 in the same way as described for valuel.
» Save the block.
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Parameter table The parameter table shows the following entries, now:
Edl Fc1 of CPU31XSC.PRI (OFFLINE)

<FC1x " Vergion:1.0 Authornb Mamenb  Family:nb
j Adress | Declaration Mame | Type | Initial value | Comment

0o valuel INT 1. comparison value
20 _ value2 INT 2. comparizon value
out
in_out {3
temp T

Enter the program As requested in the job definition, the corresponding output is activated
depending on the comparison of valuel and value2. For each comparison
operation a separate network is to be created.

» The program is to be created as FBD (function block diagram). Here
change to the FBD view by clicking at FBD.

Network 1: <Title of Network:
Betwork comment=

» Click to the input field designated as "empty".
The available operations may be added to your project by drag&drop

from the hardware catalog or by double click at them in the hardware
catalog.

* Open in the catalog the category "Comparator" and add the operation
"CMP==I" to your network.

EJ Fe1) of CPUB1XSC.PRY (OEFLINE)

i [« | Ealalogl B Call structure
<FC1> "™ Version:1.0 Author. Mamenb  Familynb +-[ &] Bit logic ~
j Adress | Declaration Name | Type ‘ Initial walue | Comment | [>] Comparatr

0.0 waluel INT 1. compa 5] ChP ==l

value? INT 2. compa / CMP <31

CHP >l

CHP <l

CMP >

CHP <=

CHP ==D

CMP <D
CHWP>D

CHP <D
CMP>=D

CHP <=D

CHP ==R

CMP >R

CHP >R

CHP <R
CMP>=R

>] CMP<=R

Ll Mvwerter >
Description:

Compare Integer For Equal Ta

temp T

<

rlnck commert= /
Network 1: 4Title of Net.mnrk>/

Eetwork coument=

NN N W N W NS N N N N W N

HNE S gy 8]

» Click to the input left above and insert valuel. Since these are block
parameters a selection list of block parameters may be viewed by
entering "#".

» Type in "#" and press the [Return] key.

» Choose the corresponding parameter and confirm it with the [Return]
key.

* Proceed in the same way with the parameter value2.
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Adding a new
network

The allocation to the corresponding output, here Q 124.0, takes place with
the following proceeding:

* Open in the catalog the category "Bit logic" and select the function
"--[=]". The inserting of "--=" corresponds to the WinPLC7 shortcut [F7].

* Insert the output Q 124.0 by clicking to the operand.

Network1 is finished, now.

For further comparisons the operations "CMP>|" at Q 124.1 and "CMP<I"
at Q 124.2 are necessary. Create a network for both operations with the
following proceeding:

« Move your mouse at an arbitrary position on the editor window and
press the right mouse key.

» Select at the context menu "Insert new network". A dialog field is
opened to enter the position and number of the networks.

* Proceed as described for "Network 1".

+ Save the FC 1 with File > Save content of focused window respectively
press [Strg]+[S].

7-6
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FC 1 After you have programmed the still missing networks, the FC 1 has the
following structure:

Netvmork 1: fetwork titcle=

hetwc\rk Comment =

| 5TL FEL LAT
CHMFP
fraluel — =7 I

Qlz4. 0

Fralue? —EI

Netvmork 2: HNetwork title=

hetwnrk Comment =

| STL FED LaD

CHFP

fraluel — I

QlE4. 1

Fralue? —EI

Netwwork 3: HNetwork titcle=

hetwnrk comment =

| BTL FED LAD
CHMF
fraluel e =TI

Qlz4.2

fraluef — _EI
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Creating the block  The FC 1 is to be called from the cycle OB 1.

OB 1 « To create the OB 1 either you select File > Create new block or click to
button [Display OB 1] and create the OB 1.

» Change to the STL view.

» Type in "Call FC 1" and press the [Return] key. The FC parameters are
automatically displayed and the following parameters are assigned:
Netwmork 1: Network title=

Hetwo rk comment=

| =STL FED LAD |
o: CALL FC 1
1: valuel:=10
£: wvaluez:=10

+ Save the OB 1 with File > Save content of focused window respectively
press [Strg]+[S].

Test the PLC With WinPLC?7 there is the possibility to test your project in a simulator.

program in the « Here select "Target: Simulator".
Simulator HIEWinPLC7 ¥4.19. - CPU31XSC.WS7

Fle Edt Block PLC Wiew L Extras Tools Window Help

o0 - @ B | & 60| oE 30 2B se e (8] 2] [5] oL S 7 [0B1 = |[Target: Simulator | -

LMCPUSTXSCACPU 3RS CACPUZTASC.PRY - (Simulator aciive] . l m i
s Target: MH.J-MetLink

Target: TCP/IP-Direct

Target: MHJ-NetLink TS

Target: NETLink PRO TCPAP

Target: SIMATIC NET

Subsproject Blocks

B Target Simulator ]
W CPU3XSC 2

« Transfer the blocks to the simulator with PLC > Send all blocks.

» Switch the CPU to RUN, by clicking to the photo "Switch/Operating
mode" and select in the dialog window the button [Warm restart]. The
displayed state changes from STOP to RUN.

» To view the process image select View > Display process image
window.

* Double click to the process image and enter at "Line 2" the address
PQB124. Confirm with [OK]. A value marked by red color corresponds to
a logical "1".

* Open the OB 1 with the button [Display OB 1].

» Change the value of one variable, save the OB 1 and transfer it to the
simulator. According to your settings the process image changes
immediately. The status of your blocks may be displayed with Block >
Monitoring On/Off.

7-8 HB145E - CPU - RE_517-2AJ02 - Rev. 10/23



Manual VIPA System 500S SPEED?7 Chapter 7 WinPLC7

Visualization via A further component of the simulator is the PLC mask. Here a CPU is
PLC mask graphically displayed, which may be expanded by digital and analog
peripheral modules.

As soon as the CPU of the simulator is switched to RUN state, inputs may

be activated by mouse and outputs may be displayed.

* Open the PLC mask with view > PLC mask. A CPU is graphically
displayed.

» By clicking the right mouse button within the PLC mask the context
menu is opened. Choose for this example "Insert 16-port digital input
module". The module is displayed at the right side of the CPU.

* Double-click to the output module, open its properties dialog and enter
the Module address 124.

» Switch the operating mode switch to RUN by means of the mouse. Your
program is executed and displayed in the simulator, now.

[e W sNeNeNeNeNeol -
o =] =]

gle
ge
4l
1°|
1|
41
gie
gl
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Project
engineering for
deployment in
the CPU 51xS

Precondition

Hardware
configuration

For the output in the CPU 51xS the following should apply:
if valuel = value2 activate bit memory M 124.0
if valuel > value2 activate bit memory M 124.1
if valuel < value2 activate bit memory M 124.2

You have administrator rights for your PC.
WinPLCY is installed and activated as "Profi" version.

Your CPU 51xS is installed and the PG/OP channel may be accessed
via Ethernet.

WinPCap for station search via Ethernet is installed.

The power supply of the CPU and the I/O periphery are activated and
the CPU is in STOP state.

Start WinPLC7 ("Profi" version).
Create and open a new project by File > Open/create a project.

For the call of the hardware configurator it is necessary to set WinPLC7
from the Simulator-Mode to the Offline-Mode. For this and the communi-
cation via Ethernet set "Target: TCP/IP Direct".

1 WinPLCT ¥4.19 - CPLI31XSC.WST
File Edt Block PLC View Eztras Tools MWindow Help

- BEEG D S 60 sH 2 B e e ~|[Target: Simuator B
- wilator

UACPU31SCACPUSTXSCACPUSTXSC PR [Simulator active]
£l

Subproect.. Blacks

B Taraet Simulator
W CPU3IHSC i

@ Cotelog | § Calstuctue |

iiect
Taiget MHJ-NelLink TS
Target NETLink PRO TCP/IP
Target SIMATIC NET

# [ &] Bit logic A
- [>] Comparatar

+ fae] Conver ter

Start the hardware configurator with & . Please regard an object is
selected with a double click at an object in the hardware configurator.

Choose in the register Select PLC-System the parameter
"VIPA SPEED7" and click to [Create]. A new station is created.

Save the empty station. A station name and a comment may be entered
before saving.

By double click choose the according VIPA CPU in the hardware catalog
at CPU SPEED?7.

For output place a digital output module and assign the start address 124.
Save the hardware configuration.
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Online access via
Ethernet PG/OP
channel

Transfer hardware
configuration

Open the CP343 properties by double clicking to the CPU at slot 2 in the
hardware configurator and selecting [Ethernet CP properties (PG/OP
channel)] respectively by double clicking at "SPEED7 Ethernet (CP343)"
slot 11 at URS.

Chose the register Common Options.
Click to [Properties Ethernet].
Choose the subnet "PG_OP_Ethernet".

Enter a valid IP address-and a subnet mask. You may get this from your
system administrator.

Close every dialog window with [OK].
Select, if not already done, "Target: External TCP/IP direct".

Open with Online > Send configuration to the CPU a dialog with the
same name.

Click to [Accessible nodes]. Please regard to use this function it is
necessary to install WinPCap before!

Choose your network card and click to [Determining accessible nodes].
After a waiting time every accessible station is listed. Here your CPU
with IP 0.0.0.0 is listed, too. To check this the according MAC address
of the CPU is also listed.

For the temporary setting of an IP address select you CPU and click to
[Temporary setting of the IP parameters]. Please enter the same IP
parameters, you configured in the CPU properties and click to [Write
Parameters].

Confirm the message concerning the overall reset of the CPU. The IP
parameters are transferred to the CPU and the list of accessible stations
is refreshed.

Select you CPU and click to [Confirm]. Now you are back in the dialog
"Send configuration".

Choose your network card and click to [Send configuration]. After a
short time a message is displayed concerning the transfer of the
configuration is finished.

Note!

Usually the online transfer of the hardware configuration happens within
the hardware configurator.

With File > Save active station in the WIinPL7 sub project there is also the
possibility to store the hardware configuration as a system file in WinPLC7
to transfer it from WinPLC7 to the CPU.

The hardware configuration is finished, now and the CPU may always be
accessed by the IP parameters as well by means of WinPLC?7.
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Programming of The PLC programming happens by WinPLC7. Close the hardware
the FC 1 configurator and return to your project in WinPLC7.

The PLC program is to be created in the FC 1.

Creating block FC 1« Choose File > Create new block.
» Enter "FC1" as block and confirm with [OK]. The editor for FC 1 is

called.
Creating In the upper part of the editor there is the parameter table. In this example
parameters the 2 integer values valuel und value2 are to be compared together. Since

both values are read only by the function, these are to be defined as "in".

o Select the "in -->" row at the parameter table and enter at the field
Name "value1". Press the [Return] key. The cursor jumps to the column
with the data type.

» The data type may either directly be entered or be selected from a list of
available data types by pressing the [Return] key. Set the data type to
INT and press the [Return] key. Now the cursor jumps to the Comment
column.

» Here enter "1. compare value" and press the [Return] key. A new "in -->"
row is created and the cursor jumps to Name.

» Proceed for value2 in the same way as described for valuel.
» Save the block.

The parameter table shows the following entries, now:

EX FC1 of CPU31XSC.PRI (OFFLINE)

<FC1x " Vergion:1.0 Authornb Mamenb  Family:nb

j Adress | Declaration Mame | Type | Initial value | Comment
0o valuel INT 1. comparison value
20 i value? INT 2. comparizon value
out Qe
in_out {3
temp T

Enter the program As requested in the job definition, the corresponding output is activated
depending on the comparison of valuel and value2. For each comparison
operation a separate network is to be created.

» The program is to be created as FBD (function block diagram). Here
change to the FBD view by clicking at FBD.

Network 1: “Title of Metwork:

Betwork comment=

» Click to the input field designated as "empty".
The available operations may be added to your project by drag&drop

from the hardware catalog or by double click at them in the hardware
catalog.
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» Open in the catalog the category "Comparator" and add the operation
"CMP==[" to your network.

¥

El FC1 of CPU31XSC.PRY (OFFLINE)

5 a Ealalngl B Callstructure

<FC1> "™ Version:1.0 Author. Namenb Familynb +-[#] Bit logic ~

j Adress | Declaration MName | Tupe | Initial valus | Comment | = [>] Comparator
0o waluel INT 1. compa 3] CMP ==l

2.0 BRI value2 INT 2. compa / 5] WP ol

out & >] TP

in_out = 3] CMP <l

temp T >] EMP 3=l

>] CMP <=l
>] CMP==D
< 5] CHP D
B >] CMP>D
lock comment= >] CMP <D
»] CMP2=D
>] CMP<=D
Network 1: <Title of Net,work/ 7 CMP =R
Hetwork comment= e >] CWF OR
STL FED ] CP >R
77777777777777777777777777777777777777777777777777777777777777777777777777777777777777 >] CMP <R
R >] CHP =R
| P <R

sl - - Lol Crwvveter s
2 _ s Description;
St R A ©  |Compare Integer For Equal To
< -TITLINT)

» Click to the input left above and insert valuel. Since these are block
parameters a selection list of block parameters may be viewed by
entering "#".

» Type in "#" and press the [Return] key.

» Choose the corresponding parameter and confirm it with the [Return]
key.

* Proceed in the same way with the parameter value2.

The allocation to the corresponding bit memory, here M 124.0, takes place
with the following proceeding:

» Open in the catalog the category "Bit logic" and select the function
"--[=]". The inserting of "--=" corresponds to the WinPLC7 shortcut [F7].

» Enter the bit memory M 124.0 by clicking to the operand.

Network1 is finished, now.
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Adding a new For further comparisons the operations "CMP>|" at M 124.1 and "CMP<I"
network at M 124.2 are necessary. Create a network for both operations with the
following proceeding:

« Move your mouse at an arbitrary position on the editor window and
press the right mouse key.

* Select at the context menu "Insert new network". A dialog field is
opened to enter the position and number of the networks.

* Proceed as described for "Network 1".

+ Save the FC 1 with File > Save content of focused window respectively
press [Strg]+[S].

After you have programmed the still missing networks, the FC 1 has the

following structure:

Network 1: Network titcle=

Hetwu:- rk comment=

| STL FED LAD

Fraluel e
Mlz4._ 0

Hralue s m— _EI

Network 2: Network titcle=

hetwn rk comment=

CHMP

fraluel —— =I

Mlz4.1

fralue? —— —EI

Netwwork 3: Metwork title=

Hetwo rk comment=

| STL FED LAD

CHFP

fraluel —— <I

HMlzd =2

FUalUe? e —EI
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Creating the block
OB 1

Transfer PLC
program to CPU
and its execution

The FC 1 is to be called from the cycle OB 1.

To create the OB 1 either you select File > Create new block or click to
button [Display OB 1] and create the OB 1.

Change to the STL view.

Type in "Call FC 1" and press the [Return] key. The FC parameters are
automatically displayed and the following parameters are assigned:
Netwmork 1: Network title=

Hetwnrk COomment =

| =STL FED LAD |
o: CALL FC 1
1: valuel:=10
£: wvaluez:=10

Save the OB 1 with File > Save content of focused window respectively
press [Strg]+[S].

For transfer to the CPU set the transfer mode to "Target: TCP/IP-
Direct".

For presetting the Ethernet data click to [...] and click to
[Accessible nodes].

Choose your network card and click to [Determining accessible nodes].
After a waiting time every accessible station is listed.

Choose your CPU, which was provided with TCP/IP address parameters
during the hardware configuration and click to [Confirm].

Close the "Ethernet properties" dialog with [OK].

Transfer the blocks to your CPU with PLC > Send all blocks.
Switch your CPU to RUN state.

Open the OB 1 with the button [Display OB 1].

Change the value of one variable, save the OB 1 and transfer it to the
CPU. According to your settings the process image changes imme-
diately. The status of your blocks may be displayed with Block >
Monitoring On/Off.
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